


Chapter 10. Preparing data to print using reports

In this section:

Creating a tabular report with multiple tables

Altering the presentation of controls on a page

Adding a running sum

Managing data and page breaks

Adding sorting and grouping on reports

Avoiding blank pages

Adding conditional formatting

Creating a single record report with the Report Wizard

Creating a parent/child report

Using labels and managing columns and rows

Working with layout view, report view, and Print Preview

Just as forms allow you to produce stunning on-screen presentations of
data, reports offer a similar feature when you need to get a printed copy
of the information. The main difference between a form and a report is
that you can’t edit data in a report, and you can’t paginate and get a
good paper layout with a form.

Access has powerful wizards to allow you to construct sophisticated
presentations with reports. Like a form, a report can be based on a table
or query, and it also supports layout and design views where you can add
and change controls in a manner very similar to when you are working



with a form.

Access reports also support multiple subreports, with as forms, as well as
the use of macros and Visual Basic for Applications (VBA) to enhance
your presentations. You should be careful to note the distinction between
Print Preview and report view. Print Preview is designed to show the
report layout before going to a printer, whereas report vew is for on-
screen interaction with a report, making the report work more like a
form.

Creating a tabular report with multiple tables

Like a form, a report can have a header and footer above and below the detail
section, and within this it also supports a page header/footer. Reports are
different from forms in that they allow the detail section to be surrounded by
multiple groupings based on common field values. Each layer of grouping
supports a group header for adding titles to columns and a group footer that
can provide summary information for the group.

In this example, we show how to select fields from two related tables that
will also introduce a single grouping for the data. The Report Wizard also
prompts you to add extra levels of grouping.

Create a tabular report

1. Click the Create tab.

2. In the reports group, click Report Wizard.

3. In the Report Wizard, select your first table.

4. Choose fields from the first table.



5. On the same page, use the drop-down box to select a second, related
table.

6. Choose fields from this second table.

7. Click Next.



8. On the next page of the Report Wizard, you can choose how to view
your data. In our example, we’ve chosen By Customers.

9. Click Next.

10. On the next page of the Report Wizard, select additional fields to group
the data. Click Next.



11. On the next page of the Report Wizard, choose to sort by one or more
fields in the detail section.

12. Click Next.



13. On the next page of the Report Wizard, select the layout and orientation
for the report. Change the Layout option to Block.

14. Click Next.



Tip

If you create the report based on a single table or if you create a query
involving a single table, the wizard will show different options for
Layout (Columnar, Tabular, or Justified). Choose Tabular.

15. On the next page of the Report Wizard, optionally change the name of
the report and then select whether to open the report in Print Preview or
Design view. Click Finish. The completed report is now displayed in
Print Preview.



16. On the Home tab, click View, and select Design View from the
submenu.



17. For our example, in Design view you can see a new additional grouping
on CustomerID added by the Report Wizard around the detail section. In
this case, the grouping has a header but no footer. Adjust the width of
any fields where the label or data is not fully visible.

Tip

When a number or date field does not have enough space to display the
information, the data will be shown with pound or hash (#) symbols. In this
situation, you need to alter the layout to resize the field to display the
information.

Altering the presentation of controls on a page



In all these examples, we prepared our report using the Report Wizard, which
means that the controls are not locked into a layout. We start by looking at
how to perform basic adjustments to the presentation of controls on a report,
such as altering a control width, or alignment, and splitting label text over
multiple lines.

Unlike a form, which has a default view that you can set to Single Form or
Continuous Form, a report always displays a continuous table of data.
However, by moving controls and labels into the Detail section or group
header/footer sections, we can change a tabulation to a single record style of
presentation.

Alter the size and position of a control

1. Right-click the report in the navigation pane, and select Design View.

2. If you have a label that is too long and overlaps other labels, click into
the text on a label in the page header and position the cursor where you
want to split the label text over two lines.

3. Press Ctrl+Enter to split the title. (Shown here is the result of doing this
on the Order Date label.) The page header’s height will increase to
accommodate the label over two lines.



Tip

If you already have a report open, use the View button on the Home tab
to switch to Design view.

4. To move a label and the control in the detail section together, click to
select a label.

5. Hold down the Ctrl key, and select the corresponding field in the detail
section. Use the mouse to drag both the label and field to a new position.

6. If you have a control and label that are not aligned, click to select a
label.



7. Click to select the control in the detail section, holding down the Ctrl
key so that both the label and the other control are selected.

8. Click the Arrange tab in the Report Design Tools tab.

9. Click Align in the Sizing & Ordering group.

10. On the drop-down menu, click Left to left-align the controls.

11. To make a label and control width the same, click Size/Space in the
Sizing & Ordering group.

12. On the drop-down menu, select To Widest, which will change both
controls to the largest width.



Tip

To get fine control over moving a label, you can use the arrow keys to move
the label and control. Holding down the Ctrl key while pressing the arrow
keys will move the controls in smaller increments, and holding down the
Shift key while pressing the arrow keys will resize the controls.

Working with controls and sections

One main differences between reports and forms is that reports have more
sections, and by using grouping, further sections can be added to the report.
You will often need to increase or decrease the available space in a section
and move controls and labels between sections.

When moving controls from a detail section into a group header, you can
produce a presentation that combines the tabulation of the detail section with
a single record presentation in the header.

Move controls between sections

1. With your report in Design view, drag down any closed group header
section to make space for moving controls.



2. We now want to reposition all labels inside the CustomerID group
header so that they are repeated for each customer record. Drag the
labels from the page header section into the group header. Some labels
can be moved individually, and others can be moved with multiple
labels selected.



Tip

Sometimes you might want to show a grouping field in the detail section
while suppressing the display of duplicate values, or you might have
other fields in the report where duplicate values need to be suppressed.
Each control has a Hide Duplicates property to support this.

3. Move the controls that are common to the grouping field from the detail
section into the group header. In our example, these are all the customer-
specific fields. The group header now contains the parent fields, and the
detail section contains the child fields.

Tip

When you move a label from a page header and its associated control has
been moved from another section, notice that the label and control do not
move together. You can attach the label to the control by cutting the label
(press Ctrl+X) and pasting it onto the selected control. Also, to move the
label to one section and the control to another section, cut the label and paste
it into a different report section.



Using the Can Grow and Can Shrink Properties

The Section properties are related to controls, which also have Can Grow and
Can Shrink properties that allow them to expand or contract to display a
larger area of data. This means that you can manage the available spaces for
each section and control. You can see how information for the company
name and other columns can be truncated, which you can alter to grow and
display the truncated data.

Allow a section and controls to grow and shrink

1. In Design view, select the Detail section.

2. In the Tools group on the Design tab, click Property Sheet.

3. Click the Format tab.

4. Set the Can Grow property to Yes, and set the Can Shrink property to
Yes.

5. Use the Ctrl key to select multiple controls.



6. Change the Can Grow property to Yes, and set the Can Shrink property
to Yes.

Tip

A fantastic feature in Access is that it allows you to change common
properties for multiple controls at the same time. As you select multiple
controls, the available properties will sometimes be reduced to only those
properties common to the selected controls.

Tip

The Section properties are related to controls, which both have Can Grow and
Can Shrink properties to allow them to expand or contract to display a larger
area of data. This means that you can manage the available space for the
controls and each section.



Adding a running sum

Text box controls have a Running Sum property, which, when set to true,
causes the control to display a running total of a numerical field. You can set
the Running Sum property either to ignore any groups and run over all data in
the report or to run over a group, where it runs over only a single group value
and is reset before producing results for the next group.

In our example, we apply the Running Sum property to the quantity for a
sales order, and we set the running total to be over a grouping on the
OrderID.

Add a running sum

1. In Design view, click a field that contains numerical data.

2. In the Tools group on the Design tab, click Property Sheet.

3. Click the Data tab.

4. Change the Running Sum property to Over Group.



Tip

When adding a running sum or any summary calculation, you might want to
display this at the bottom of each page. If you try to place a bound control in
the page footer, you will see an error message displayed. To add these or
similar calculation to a page footer, you must add an unbound control in the
footer and then add program code to the report section. You might find it
simpler to display the control in a group footer.

Managing data and page breaks

It is often very important to manage page breaks in your data. In this section,
we look at two techniques for managing this. The first technique involves
setting the Force New Page property (available on all sections except for the
page header/footer). The second technique uses a property of all sections of a
report (except the page header/footer) Keep Together. When this property is
set to Yes, the report will throw a new page if it cannot fit all information
within the section on the current page. By default, this property is set to true.



You should also look very carefully at the Keep Together property described
in the next task, Adding sorting and grouping on reports, because these topics
are interrelated.

Force a new page

1. In Design view, select a group footer section.

2. In the Tools group on the Design tab, click Property Sheet.

3. Click the Format tab.

4. Set the Force New Page property to After Section.

Tip

In Design view (on the Design tab in the Controls group), clicking the
Controls icon displays a Page Break control; this gives you finer control of



where page breaks occur in a report.

Keep results together on the same page

1. In Design view, click Group & Sort in the Grouping & Totals group on
the Design tab.

2. In the Group, Sort, And Total section, click More.

3. Select the option to keep the whole group together on one page.



Caution

The Keep Together property keeps together only the information being
displayed in the section to which it applies for each record. Groups have their
own properties, which you can set to keep a group header, footer, and its
detail section displayed on the same page.

Adding sorting and grouping on reports

Sorting and grouping provides a flexible way to add new sections around the
detail section to organize your records. Each sort or group can have a header
and/or footer area. The header displays titles and columns that are common to
the records that will be displayed inside the group, and the footer displays
summary information such as a record count or the sum of a particular value.

Adding grouping to your reports allows you create a parent/child-styled
presentation of data without the need to use a subreport. In this case, you
group on a parent field and move controls into the group header/footer.

Add a sort and group

1. In the Grouping & Totals group on the Design tab, with a report in
Design view, click Group & Sort.

2. In the Group, Sort, And Total section, click Add A Group.



3. Select a field for the group.



4. In the Group, Sort, And Total section, click More.

5. Click the With No Totals drop-down list.

6. Select the primary key field.

7. In the Type field, select Count Records.

8. Select the Show Grand Total check box.



9. Select the Show Subtotal In Group Footer check box.

Tip

Access has very powerful grouping features that allow you to group on
calculated expressions or incorporate user-defined VBA functions for
the grouping.

10. Select Keep Whole Group Together On One Page. Your report will now
include the new grouping around the detail section.

11. On the Design tab, in the Tools group, click the Add Existing Fields
icon.

12. Click the Country field.

13. Drag the Country field into the group header.

14. Drag the titles from the Page Header section into the group header.



Tip

A fantastic feature in Access is that it allows you to change common
properties for multiple controls at the same time. As you select multiple
controls, the available properties will sometimes be reduced to only those
properties common to the selected controls.

Avoiding blank pages

When you are formatting a report, if the width of the page allowing for
margins exceeds the available paper width, the report will spill over onto
additional pages. Sometimes this can display more data, and on other
occasions, it displays alternating blank pages.

Because a report is set up with a particular printer installed on a system, when
the report is used on a system with an alternative printer that supports
different margins, you can find that a working report on one system produces
blank pages on another system and therefore needs adjustment.



Remove a blank page

1. With a report opened in Design view, switch to Print Preview to see the
formatting problem, and then Close Print Preview to return to Design
view.

2. In Design view, click the Page Setup tab.

3. Click Page Setup in the Page Layout group.

4. Reduce the margin width, and click OK.



Tip

Other points to consider when removing blank pages include switching from
portrait to landscape orientation, shrinking control widths, setting the control
and section Can Grow properties to Yes, or moving labels and controls
together in a section to provide a columnar layout, making the section
narrower and taller.

Adding conditional formatting

Conditional formatting applies to both forms and reports and allows you to
create colorful presentations in which you format a cell in a record to
highlight its value as compared to other fields or values. A simple example
would be to display all cell values of less than zero on a red background.

In addition to changing the formatting colors of a cell, you can display a data
bar that shows the value compared to the field’s range of values in the report
or against a specific range of values, providing a quick visual indication of
how the data compares against other values.



Add conditional formatting

1. Select a field that contains numerical values.

2. Click Conditional Formatting in the Control Formatting group on the
Format tab.

3. Click New Rule.

4. Change the rule type to Compare To Other Records.

5. In the Type field, change Lowest to Number and Highest to Number.
(The default compares against the lowest and highest values in the
report.)

6. Type Values for the shortest and longest bars. In our example, we
entered 100 to 1000.

7. Click OK. (Also click OK to close the Conditional Formatting Rules
Manager dialog box, and select Layout View from the View drop-down
menu on the Design tab.)



8. In layout view, click Conditional Formatting to make further changes to
the presentation.

Creating a single record report with the Report
Wizard

In a single record report, the field labels and controls are displayed in the



Detail section; this is different from a tabular presentation because the
controls and labels are attached and move together in the Detail section. In a
tabular report, the labels are displayed in a section header and the controls are
displayed in the Detail section, and they do not move together unless the
report was created via the Report icon, which adds layouts to the controls.

If you create a report either by selecting from multiple tables in the Report
Wizard or by using a query containing multiple tables, the Report Wizard
does not display a columnar option to lay out the record but displays only
tabular layout options.

Create a single record report

1. Click the Create tab.

2. Click Report Wizard in the Reports group.

3. Select a single table.

4. Select several fields from the table.

5. Click Next.



6. Do not select any fields for grouping. Click Next.

Tip

Do not add any grouping options in the Report Wizard. Otherwise, you
will not be able to select a columnar report. You can add groupings to



the report after you have finished using the Report Wizard.

7. Select any fields for sorting the records.

8. Click Next.

9. Choose Columnar for the report layout.

10. Click Next. On the final page of the Wizard enter a name for the report
and click Finish.



Tip

When viewing your report in Print Preview, you can use the Zoom icon on
the Print Preview tab to alter the on-screen presentation of the data.

Creating a parent/child report

A parent/child report is similar to a parent/child form, where one table or
query provides the parent record and another table or query contains the
related child records, which are displayed in a subreport.



The Report Wizard does not have any options to create these parent/child
reports. You start by creating two reports, one of which will be the parent and
the other of which will be the child. Then you can drag the child report onto
the parent report (while it is in Design view).

As an example, we will use a tabular list of orders, which we can create by
using the Report Wizard. The table on which this report is created contains a
linking field, which is the CustomerID, although the field does not need to be
displayed on the report.

Our parent report will be a columnar report that we create by using the Report
Wizard and which displays customer details. We will start with that report in
Design view. The primary key on the parent is CustomerID, which will be
used to link the parent report to the child subreport.

Create a parent/child report

1. Create a tabular subreport by using the Report Wizard, and then save
and close the report.

2. With the parent report open in Design view (we have moved several
fields to provide space for the subreport), position the report next to the
navigation pane and select the child report to be positioned on the parent
report.



3. Drag the child report onto the parent report. This creates a subreport
control. Select Print Preview from the View drop-down menu on the
Design tab.

Tip

If you are having problems with the data in a subreport not being filtered
by the parent record, display the Report Properties pane and examine the
values in the Link Master Fields (parent) and Link Child Fields
properties. These properties also have build buttons that can assist you
in selecting the fields to use when linking the parent report to the child
report.

4. To see how the report would require further adjustment to prevent the
split over two pages, click Two Pages on the Print Preview tab. In this
example, the subreport control width needs to be reduced.



Tip

You might find that it is easier to alter your presentation by removing any
control layouts. However, if you do this, you will lose many of the benefits
associated with working in layout view. By working with control layouts,
using the icons in the Rows & Columns group on the Arrange tab, you’ll find
that altering the layout is greatly simplified.

Using labels and managing columns and rows

Reports support portrait or landscape layouts, and in both cases you can alter
the presentation to include Columns. With the columns presentation (which is
used for labels and can also be used to present a directory-style layout of your
data), the layout of records is split into several columns. The report can either
show data in each column—filling the page for the first column and then
moving to the next column—or display the data by filling all columns from
left to right, working down each row in the page.

The Label Wizard is the easiest way to generate a set of labels, which you can
then further adapt, although you can add this feature to any existing report.

Add a columns presentation



1. Select a table or query in the navigation pane.

2. Click the Create tab.

3. In the Reports group, click Labels.

4. Select an appropriate label.

5. Click Next, and on the next wizard page where you can change the
fonts, click Next.

6. Click a label field.

7. Add the field to the label expression, and repeat to build up a list of
fields in the label.

8. Click Next. The next wizard screen allows you to choose fields for
sorting. Make any appropriate choices, and click Next.



9. Add a suitable title the report.

10. Click Finish.



11. In the Page Layout group, you can click Columns to make further
changes to the label layout. This will display the Page Setup popup
window with the Columns tab selected.

Working with layout view, report view, and Print



Preview

When you double-click a report in the navigation pane, it opens the report in
report view, which displays all the records as a continuous list. You can then
switch the report into Print Preview to see the report paginated as it would be
printed.

You can create forms and reports with controls organized in a layout. The
layout presentation feature has the advantage of allowing you to easily
modify the report while viewing data in layout view. Clicking the Report
button on the Create tab will create a tabular report where the controls are
placed in a layout. The options on the Arrange tab are intended for use with a
layout presentation.

Alter a report in layout view

1. Select a table in the navigation pane.

2. Click the Create tab.

3. Click Report in the Reports group.

4. Click in a column row or heading.

5. Click the Arrange tab.

6. Click Select Column in the Rows & Columns group. You can reposition,



the selected column by dragging it to the left or right.

Tip

The child report contains a large report header (OrderList), which can be
removed from the child report. Also, the heading titles for the child report are
not displayed. To display these titles, you need to add a suitable grouping
header on the child report and then move the column titles Order ID, Order
Date, and Required Date from the page header into the group header in the
subreport.

Switch between report view and Print Preview

1. Double-click a report to open it in report view.

2. Click the View drop-down arrow, and select Print Preview.



Tip

As an alternative method of opening a report, in the navigation pane you can
right-click a report and choose how to view the report, selecting Open
(Report View), Layout View, or Print Preview. If you open the report in Print
Preview, closing the view will close the report, but if you open the report in
report view or layout view and then switch to Print Preview, closing Print
Preview will leave the report displayed either in report view or in layout
view.

When a report is displayed, you can use the icons on the status bar (lower
right of the screen) to switch between the available views. Even if you first
opened your report in Print Preview, you can use these icons to quickly select
any other view without closing the report.



Chapter 11. Exchanging data

In this section:

Importing data and objects from Access

Linking to data in Access

Importing data from Excel

Linking to data in Excel

Importing data from text files using specifications

Exporting data to Excel

Refreshing linked tables when files are changed

Working with saved imports and exports

Exporting data as PDF documents

Access has fantastic support for getting data into and out of your
database by using import and export procedures. You can import data
into existing tables, or create new tables as the data is imported. In this
section, we demonstrate the most popular formats for exchanging data.

In addition to importing and exporting, you can link to the data. This
provides a dynamic link so that you will always see the latest data in the
other data source, and when linked to data in another Access database or
Excel spreadsheet, it will also dynamically reflect any changes made to
the data structures in those files.

If you have data in databases such as IBM, Oracle, Informix,
SharePoint, or SQL Server, you will find that Access also supports
methods to exchange data by linking or importing from those sources via



ODBC (Open Database Connectivity), which is a standard method for
interconnecting systems.

Importing data and objects from Access

When you import from another Access database, you can choose to import
any combination of tables, queries, forms, reports, macros, or modules. For
each type of object, you have the option to select all the objects or to select
individual objects of each type.

When importing related tables, you import the relationships by default.
Options are available to exclude relationships, to import only structures and
not data, and to create new tables when importing data from queries rather
than importing the query.

Import data and objects from an Access database

1. Click Access in the Import & Link group on the External Data tab.

2. Keep the default selection to import tables, queries, forms, reports,
macros, and modules into the current database.

3. In the File Open popup window, browse to locate the database file.
Select the file, and click Open.

4. Click OK.



5. Use the tabs to display objects in the database to be imported.

6. Select objects to import from each tab.

7. Click Options to see more options when importing data.

8. Click OK.



9. If you will be repeating this operation later, select the Save Import Steps
check box.

10. Click Save Import.



Tip

When you are importing an object and an existing object in the database has
the same name, Access will rename the imported object, appending a number
to the end of the name to resolve the conflict. For example, if you import a
table called Products when you already have a table with that name, the new
table will be called Products1.

Linking to data in Access

Rather than importing data from an Access database, you can create links to
the tables in an other database. You will then be connected to the live data in
the other database, and this will save you from needing to regularly import
data from the other system.



In addition to not having to copy data, if the linked tables, design is changed
in the database to which you are linked, you will automatically see those
design changes when next opening the linked table in your database. (If your
linked table is open, you will need to close it before making any design
changes in the database to the table to which you are linked.)

Link to data in an Access database

1. Click Access in the Import & Link group on the External Data tab.

2. Select Link To The Data Source By Creating A Linked Table.

3. Browse to locate the database file. Select the file and click Open.

4. Click OK.



5. Select the tables to be linked.

6. Click OK.

7. A linked table is shown with a different icon in the navigation pane.



Tip

Access databases are often designed where all the items except the Tables are
held in one database, and the Tables are held in a different database. This
method enables users to have their own copy of the application on their local
machine, but link to and share the data from another Access database on the
network.

Importing data from Excel

When importing data from Excel, if you have only one worksheet and no
named ranges defined, the wizard does not prompt you to make any
additional decisions (as described shortly in step 5). But if you have either
multiple worksheets or one or more ranges defined in a single worksheet or in
multiple worksheets, you are prompted to select either a worksheet or a
named range.

When importing data, you will also find that Access makes a best assessment
of the appropriate data type to use for each column, but you can review and
change the choice of data type before importing the data.

Import data from Excel

1. Click Excel in the Import & Link group on the External Data tab.

2. Keep the default selection to import the source data into a new table in
the current database.

3. Browse to locate the Excel file. Select the file and click Open.

4. Click OK.



5. Select the required worksheet from which to import the data, and click
Next.

Tip

The wizard also offers an option to directly append data into an existing



table. However, it is often better to import data into a temporary staging
table and then use the techniques described in Chapter 7, using action
queries to transfer the data into your main tables after checking the data.

6. If your spreadsheet includes column headings, select the First Row
Contains Column Headings check box, and click Next.

7. To change imported data types for a column, select the column. Use the
horizontal scroll bar to see more columns from the source data.

8. Select a data type in the Data Type drop-down box and click Next.

9. Allow Access to add a primary key, or choose a column to use as the
primary key. Click Next.



10. Type a name for the imported data table and click Finish.

Tip

After you complete the import steps you will be prompted with a screen to
save the imported steps. This option allows you to repeat the the saved
operation, as described later in this section.

Linking to data in Excel

The ability to link Access to data in Excel can mean that rather than
repeatedly importing data, you can link directly to the data in the spreadsheet.
This means that you will always be working with the latest dataset.

If you link to an Excel Worksheet and columns are subsequently altered in
the spreadsheet, when you reopen the table you will see the linked data



reflecting any structural changes to the spreadsheet. If you would prefer not
to see these changes, you could link to a named range of cells in a worksheet
instead.

Link to data in Excel

1. Click Excel in the Import & Link group on the External Data tab.

2. Select Link To The Data Source By Creating a Linked Table.

3. Browse to locate the Excel file. Select the file and click Open.

4. Click OK. You will be asked the same series of questions as described
in the preceding task, Import data from Excel (steps 5 to 10).



5. The linked table is shown with a different icon in the navigation pane.

Tip

When you link to an Access table, the linked table will allow you to edit and
insert data, but when you are linked to an Excel spreadsheet, you will find
that the Access application cannot modify the data because you have a read-
only link to the Excel data.

Refreshing linked tables when files are changed

If you have linked tables to Access or Excel and if the files to which you are
linking are moved to a different folder or the file name is changed, the links
will no longer work. The Linked Table Manager allows you to select several
linked tables and then inform Access of the new file path/name to the linked
file.

If you know that a file name/path has changed, when relinking you should
select the option Always Prompt For A New Location. If that option is not
selected, when you refresh the links you will be prompted to specify a valid
file path each time a link cannot be refreshed.

Refresh linked tables

1. Click Linked Table Manager in the Import & Link group on the External
Data tab.



2. Click to select any links that need to be refreshed.

3. Select the Always Prompt For New Location check box.

4. Click OK.

5. Locate the file at the new location, and click Open.



Tip

For links to Access and Excel worksheets, if the source data structure
changes, the links do not need to be manually refreshed; they automatically
display the latest structure. But if the links connect to tables in SQL Server or
another database server, when the table structures change in the other
database you will need to refresh those links.

Importing data from text files using specifications

The Import Text Wizard is a very sophisticated tool that allows you to import
data in a wide variety of formats. The most popular text format is called
delimited. In this format, columns are separated by a comma and text fields
are surrounded with double quotes. You might occasionally come across a
file that uses different delimiters, and the wizard can accommodate this.

The second format you might come across is fixed width, where every field
has a fixed number of characters. The wizard will also help you to decide on
column boundaries when you are working with this format.



Import data from a text file

1. Click Text File in the Import & Link group on the External Data tab.

2. Keep the default selection to import the source data into a new table in
the current database.

3. Browse to locate the text file. Select the file and click Open.

4. Click OK.

5. Select either Delimited or Fixed Width, according to the text file format.
Delimited is the more common choice. If you want to see more
advanced features of the Import Text Wizard, continue with step 6;
otherwise, click Next and proceed to step 10.



6. Click Advanced.

7. Adjust any of the advanced settings associated with the text import.

8. Click Save As to save your settings as a specification.



9. Type a name for the specification, and click OK. Click OK to close the
Advanced screen.

Tip

Import specifications allow you to set up specialized settings for
controlling how a file is imported. You can then reload them when
repeating an import process. Usually, you will not need this extra
flexibility, but if required, it can prove very useful.

10. If your first row in the text file contains field names, select the First Row
Contains Field Names check box, and click Next. (Our example does not
contain this row.)



11. To change imported data types for a column, select the column.

12. Select a data type in the Data Type drop-down box. Use the horizontal
scroll bar to view the other columns from the data source.

13. Click Next.



14. Allow Access to add a primary key, or choose a column to use as the
primary key. Click Next.



15. Type a name for the imported data table, and click Finish.



Tip

When importing data Access gives you three choices for setting the new
primary key on a table. The simplest option is to accept the default choice
and Let Access add primary key, this will add an autonumber field called ID
to your table.

Exporting data to Excel

Access supports a wide range of formats for exporting data, and in this task,
we demonstrate one of the most popular—Excel. After exporting data, you
are prompted to save the export. Saving an export allows you to easily repeat
it at a later date.

You can export data by using a table, query, form, or report. Using a query
allows you to choose only the required subset of data, rather than including
all the columns and rows in the underlying tables of data.

Export data to Excel



1. In the navigation pane, highlight the object you want to export.

2. Click Excel in the Export group on the External Data tab.

3. Type a file name for the exported file.

4. Choose the file format.

5. Click OK.

Tip

In Chapter 6 we explain how to create a query that prompts for filter
criteria when opened. This type of parameterized query can be used



when you are exporting data and provides a great way to add flexibility
to your export routines.

6. If you will be repeating this operation later, select the Save Export Steps
check box.

7. Click Save Export.

Working with saved imports and exports

Saving imports and exports allows you to repeatedly run data imports and



exports with minimum effort. When you first import or export data, Access
promptes you to save the import/export operation. If you save the operation at
this time, you can later take advantage of this feature to rerun the process.

If the operation involved importing or exporting data and you have an
existing file on your machine or a table in your database, you will be
prompted to overwrite the object (except when importing from an Access
database where, if the table exists, the new imported copy will be named with
a suffix, such as Products1, Products2, and so on). If you select No, the
operation will be canceled.

Run an import/export operation

1. Click Saved Imports in the Import & Link group on the External Data
tab.

2. Select an import to run.

3. Click Run.

4. Click Yes to overwrite the table, or click No to cancel the import.



5. Click the Saved Exports tab.

6. Select an export to run.

7. Click Run.

8. Click Yes to overwrite the file, or click No to cancel the export.



See Also

In Chapter 12 we will describe how macros can be used to repeat a saved
import/export.

Exporting data as PDF documents

A great feature in Access is the ability to easily facilitate exchanging
information in the PDF file format. This allows you to export a complex
report as a PDF file. Access also supports the alternative Microsoft standard
XPS (XML Paper Specification).

Exporting data in PDF format is not limited to exporting a report. You can



also export data in tables, queries, and forms in PDF format.

Save data as a PDF document

1. Select an object in the navigation pane.

2. Click PDF Or XPS in the Export group on the External Data tab.

3. Click Options to display other publishing options.

4. Click OK.

5. Click Publish to export the data.

Tip

If you have a report open in print preview, you can use the PDF or XPS icon



on the print preview ribbon tab to publish the report.



Chapter 12. Introducing the power of macros

In this section:

Enabling macro commands and disabling Trusted Documents

Linking together forms

Linking a form to a query

Validating data entered in controls

Making controls change other controls

Executing a saved import/export

Processing data with action queries

Unlike Excel, which has a macro recording tool that creates code that
you can then edit in the VBA editor, Access has two separate approaches
to programming. The first is macro programming (there is no recording
tool), which comes equipped with a special macro designer and set of
macro commands. The second approach is VBA programming, which
has an editor and environment very similar to the Excel programming
environment. There is a crossover between the macro commands and
VBA programming—that is, macros can be converted to VBA, and VBA
can make use of macro commands.

Macros have many uses, including linking together user interface
elements like forms, queries and reports, performing complex data
validation, or executing sequences of operations to import and process
sets of data.

In programming macros, you can save sequences of instructions either as
a stand-alone macro, which you can execute from the navigation pane, or
as an embedded macro inside a form/report.



Enabling macro commands and disabling Trusted
Documents

Before you can use macro programming in your database, you need to enable
macros in the Access installation. This process is described in Change the
default database options. Refer to this task to make any further changes to
settings described in this section.

After you enable macros, 20 macro commands will remain disabled and will
not be visible in the macro designer. These commands can be made available
only in Trusted Documents or when the Trusted Documents feature is
disabled. You should refer to your company’s policy on Trusted Documents
for advice on this. In this exercise, we demonstrate how to disable this feature
and thus enable these additional commands.

Disable Trusted Documents

1. Enable macros as described in Change the default database options, then
select Trusted Documents from the options on the left in the Trust
Center window.

2. Select the Disable Trusted Documents check box, click OK to close any
open windows, and then close and reopen your database.



Caution

The methods described in this book are intended to help you get started
quickly and should not be interpreted as recommending a standard
configuration for your Office software. For further details about Trusted
Documents and other security issues, visit the Microsoft Trustworthy
Computing page at www.microsoft.com/about/twc/en/us/default.aspx?
CE=Nav2b.

The macro commands listed in the following table operate only in Trusted
Documents. You will find that the ImportExportData, SetValue, and
SetWarnings commands are especially useful to have available when you are
creating macros.

Macro commands

Data import/export Database Filter/query/searchMacro commands

http://www.microsoft.com/about/twc/en/us/default.aspx?CE=Nav2b


commands objects commands

ImportExportData CopyObject RunSQL Echo

ImportExportSpreadsheet DeleteObject  OpenVisualBasicModule

ImportExportText RenameObject   

ImportSharePointList SaveObject   

RunSavedImportExport SetValue   

    

Tip

If you do not trust the use of these commands in your database, you might get
confused when, after searching online to find further examples, you fail to
reproduce actions; as the commands are not be listed in the macro designers
list of available actions.

Linking together forms

The OpenForm, OpenReport, OpenTable, and OpenQuery macro commands
are among the most common and easiest to use. These commands allow you
to open other forms, print reports, or display data in tables and queries.
Normally, these macro commands are used on a command button control’s
OnClick event, but they can also be used as macros independent of a form.



Each control on a form has a set of events, and the On Click event for a
button is activated when a user clicks the button. You will find that you do
not need to understand all the available events and that you can accomplish
most programming with only a few of them.

Create an embedded macro to open a form

1. With a form in Design view, click to expand the controls list, and turn
off the Use Control Wizards option.

2. Click the Button control, and click in the form to add the button to the
form.

3. In the Property Sheet pane, click the Event tab, then click the Build
button for the On Click event.

4. In the Choose Builder dialog box, select the Macro Builder, and click
OK.



5. In the Add New Action drop-down box, select OpenForm from the list
of commands.

Tip

If you leave the Control Wizard active when adding a button, after
navigating through the wizard choices, you will find that an embedded
macro has been added behind the button’s On Click event. This useful
feature might get in the way when you want to write your own
embedded macros. You can click the Control Wizard option to switch
off this feature.

6. Select another form to display by using the Form Name drop-down list
of available forms.

7. Save and close the macro design tool. If you now display your form in
Form view and click the command button, it will open the other form
that you defined in the OpenForm macro command.



8. Return to Design view, and add a text box control to the form. Ensure
that you change the control name. (In our example, it is called
txtCountry.) Save your form.

9. Click to select the button control you added in step 2. Then click the
Build button to return to the macro editor, and change the macro code
embedded on your button.

10. Change the Where Condition so that data in the form that you open will
be filtered by the data entered into the text box control. In our example,
txtCountry is the control name, and the form we are opening is based on
a table that has a field called [Country].



Tip

As you start typing in the Where Condition box, IntelliSense will help you
locate a form. After typing Forms!, you will see a list of available forms.
Then, after you select a form and type the ! character, a list of controls on the
form is displayed.

Linking a form to a query

A popular design technique in creating a user interface is to use a method
often called query by form. The idea is to create a query that has filter criteria
that directly references one or more controls on a form. The user then types a
value into the control on the form and clicks a button on the form, which
opens either a query or a form/report based on a query, where the query links
back to filter by the value entered on the form.

In our example, we will make the form open the query, but you could easily
change this to open a form or report based on that query.

Link a form to a table or query

1. With a form in Design view, add a text box control. This text box will
contain a value that will be used to filter data in a query.

2. Type a name for the text box control. (Naming controls will make



creating expressions easier when you have several controls on a form.)

3. Save the form, but do not close it.

4. Create a query, and choose a field that will be filtered against the data in
the control on the form we created.

5. Save the query.

6. Click in the Criteria row, in the column against which we’ll be filtering
the data.

7. Click Builder to open the Expression Builder popup window.



8. In the Expression Elements pane, browse the tree of information to
locate the form that you created in earlier steps. (If you have many
forms and you know that the form you are looking for is open, select
Forms; then select Open Forms to display only a list of forms that are
open. This is particularly useful when you are referencing controls on
subforms.) Select the form.

9. Double-click the text control that we added to that form. Click OK.



10. Save and then close the query. Return to your form in Design view, and
repeat steps 2–5 of the previous task (Create an embedded macro to
open a form), where we added a command button to the form and
displayed the macro design tool for the On Click event on the command
button. However, this time choose the macro command OpenQuery in
step 5.



11. From the available list of queries, select the query that you saved. Then
save and close the macro window. You will now have a form with a
control into which you can type a value and a button that opens a query
that filters the data by the choice you have typed into the control.

Tip

You can enhance this method by adding a Requery macro command, which
will update the query after you make a change in the text box on your form
without the need to close the query window.



Tip

The symbol ! is part of the syntax used to refer to objects inside a collection.
Therefore, the syntax in this example translates to “look in the Forms
collection for a form, and then look in that form’s Controls collection for a
control.”

Validating data entered in controls

Controls on a form have a Before Update event that enables you to use macro
commands to add actions when a user enters data before the entry is
accepted. You can then decide whether to accept or reject the data entered in
the control.

The Form’s Before Update event executes before a record is saved. You can
use this event to check the data, comparing values in multiple controls, before
accepting or rejecting changes. If you need to cross-validate controls, it is
often simpler to write the macro checking actions on the forms event, rather
than repeating similar operations on several different controls.

Validate data entered in a control

1. In Design view, locate a control on which you want to add validation,
and click the Event tab in the Property Sheet pane to display the event
properties. In our example, we have created a new form and added an
unbound text box control to the form.

2. Click the build button for the Before Update event, and select Macro
Builder.



3. Select the If command in the Add New Action field. This is a
conditional logic block where we can test a value and take an action.

4. Type the expression NZ(txtLowerCount) < 10; IntelliSense will
display a list of controls after you type NZ. (Our control is called
txtLowerCount.)



5. In the drop-down box below the If command, select the MessageBox
action in the Add New Action field. Type a warning message and a title
for the MessageBox action.

6. In the Add New Action field below the MessageBox action (but still
inside the If block), select the command CancelEvent. This will reject
the user’s changes.

7. Save and close the macro designer. If you now view your form and type
values in the field, you should find that the validation rule displays a
message box and cancels your action when an invalid date has been
entered.

Making controls change other controls



Controls on a form have an After Update event that occurs after a successful
Before Update event. If the Before Update event cancels the data change
because it fails validation (as previously described), the After Update event
will not fire. The After Update event is used to take action following a
successful change to data, and one possible implementation is in changing
how other controls can be used following a change in the data.

In addition to each control having an After Update event, the form also has an
After Update event, after changes have been successfully validated for the
record, which you can use to take further action based on values in several
controls.

Change other controls

1. In Design view, locate a control to which you want to add an After
Update action, and click the Event tab in the Property Sheet pane. In our
example, we took the form from the previous task (Validate data entered
in a control) and added an additional unbound text box (which has the
Enabled property set to false).

2. Click the build button for the After Update event, and select Macro
Builder.

Tip



In the macro designer, if you have a trusted database and you want to
use macro commands restricted to a Trusted Document, remember to
click Show All Actions. Otherwise, you will not see the extended list of
all available macro commands in the drop-down list.

3. On the Macro Tools Design tab, select Show All Actions. (Otherwise,
you will not see the SetValue macro command in the drop-down list of
commands.)

4. Add a SetProperty command. In our example, this will enable a second
control when the first control has been validated and the After Update
macro fires.

5. Add a SetValue macro command. In our example, we set the value of
our second control to the same value entered in the first control.
(IntelliSense will assist you when you are typing data in the Item and
Expression fields.)

Tip

The Action Catalog on the right side of our screen provides an alternative
method for both displaying the available macro commands and selecting a
command. If you double-click a command, it will be added on the left. Also
notice the warning triangle shown next to all commands that are available



only in a Trusted Document.

Processing data with action queries

Chapter 7, explains how action queries can update, insert, and delete data.
When you need processing that executes a sequence of action queries, macros
enable you to run those action queries to make bulk changes to the data in
your system.

The OpenQuery macro will either open and display the results of a selected
query or execute an action query with prompting for changing the data. By
using the Set Warnings macro, you can switch off the prompting while the
macro is executing.

In this example, we are going to use two action queries, first to empty a table
and then to populate the table with data.

Empty and populate a table of data

1. Create an action query to delete all the data in a table that you regularly
need to populate from another table of imported data.

2. Create an action query that will append a set of records from another
table to the same table from which you deleted all the records. (We are



going to assume here that you regularly import data from another system
into a table and that you then need to further process that data into other
tables in your database.)

Tip

When you are developing a stand-alone macro, you can take advantage
of the Run button on the far left of the ribbon to execute your macro
while staying in the design tool. You can also click the Single Step
button to allow execution of the macro one step at a time.

3. Click the Create tab.

4. Click Macro.

5. Add an OpenQuery command.



6. Select the query that empties the data from your table.

7. Add an OpenQuery command.

8. Select the query that adds data to the empty table.

9. Save the macro.

10. Type a name for the macro, and click OK. At this point, you should save
and test the macro.

11. Add the Set Warnings command, with Warnings On set to No. This
prevents the prompting boxes from displaying when you are executing
the query. (When you have verified that it executes correctly, you might
want to switch off the built-in warnings when executing an action
query.)

12. Add the Set Warnings command, with Warnings On set to Yes. It is very
important that you always switch the standard warnings back on.

13. Add a MessageBox command to indicate that the processing is
completed.

14. Use the up and down arrows to move your commands to the correct
position in the macro sequence.



Executing a saved import/export

Macro commands are provided for running the saved import/export processes
that we described in Chapter 11. For example, on a form, these commands
could allow you to create a button that executes a sequence of import/export
processes to manage your data.

In this example we will show how to create a macro that is not embedded
inside a form. You can then execute this macro from the navigation pane, or
alternatively, you could use the RunMacro command inside an embedded
macro on a button on a form. (Macros can run other macros.)

Execute a saved import/export

1. Click the Create tab.

2. Click Macro.



3. Click Show All Actions.

4. Select the RunSavedImportExport action. (You will need to have
already saved an import/export to use this.) Select the file to import or
export.

5. Click Save.

6. Type a name for the macro, and click OK. In the navigation pane, a new
object type will be shown (unless you have previously created macros).
Double-click the macro to execute the operation.

7. To edit your macro, display the macro in the navigation pane, right-
click, and select Design View.



Tip

You will notice when executing this macro that there is not a message
indicating that the macro has executed. As a final step, you could add a
message box to indicate that the macro has completed the export.



Chapter 13. Administrating a database

In this section:

Compacting and repairing your database

Analyzing your database

Protecting your data

Viewing object dependencies

In this section, we will look at a number of Access features that will assist
you in managing and configuring your database.

The Compact & Repair feature helps you optimize the database for best
performance and resolve any inconsistencies.

In protecting your data, we look at how to password-protect and encrypt
your database to prevent others from opening it either with Access or
with another tool.

The Analysis Tools feature enables you to use the Database Documenter
tool to produce printed documentation of your design. The Performance
Analyzer database tool will give you advice and tips on improving your
design, and you can use the Table Analyzer Wizard to restructure a table
into a more consistent format for use in a relational database.

Inside Access is a map of how all your tables, queries, forms, and reports
are dependent on each other. The Object Dependencies feature allows
you to examine this map and quickly locate dependent objects.

Compacting and repairing your database

As changes are made to your data over a period of time, such as when data is



deleted or updated, the data will eventually no longer be ordered on the
physical storage in the most efficient manner. Over time, as objects are
created and removed, the database will also grow in size. Compacting the
database reduces the size of the files and makes the database operate faster by
reorganizing the physical data. Before you can compact or repair a shared
database, you must ensure that no one is using it.

The repair operation corrects for any problems in the consistency of the data
or indexes in the database. A single process is used to both compact and
repair a database.

Compact and repair a database

1. With your database open, click the File tab.

2. Click Compact & Repair. This will compact and repair the database and
will reopen the database when the process is completed.

3. Drag your database onto the desktop to create a shortcut.



Tip

To create a shortcut, click to select the database, hold down the right
mouse button, drag the file to for example the desktop, release the
mouse button and select Create shortcuts here.

4. Right-click the shortcut, select Properties, and then edit the target by
entering a space followed by /Compact.

5. Click OK. This creates a shortcut that you can click to compact and
repair your database.



Tip

You can use the File tab Options submenu and select the Current Database
choice, where an option is provide to Compact on Close which when set
means that every time you close the database it will automatically be
compacted and repaired.



Analyzing your database

Access provides the following tools for gaining an overview of your database
structure:

The Documenter tool provides you with a basic level of documentation
on your design.

The Analyze Performance tool looks at the structure of your database
and provides recommendations for revisions that you can make to the
design of the database.

The Analyze Table tool can restructure tables to provide for a more
flexible and relational structure.

Document a database

1. Click the Database Tools tab.

2. Click Database Documenter.

3. Use the tabs and check boxes in the Documenter popup window to
select objects that you want to document.

4. Click OK to produce a report documenting the selected objects.



Tip

The default documentation can produce a large amount of paper. One of the
available options enables you to produce a shorter summary of the
information.

Analyze performance of a database

1. Click the Database Tools tab.

2. Click Analyze Performance.

3. In the Performance Analyzer popup window, use the tabs and check
boxes to select objects to analyze.

4. Click OK to receive advice about improving performance of your
database.



Analyze a table

1. Click the Database Tools tab.

2. Click Analyze Table.

3. Follow the instructions in the Table Analyzer Wizard to analyze the
design of a table.



See Also

If you need to manually undertake these operations, then in Chapter 7 we
show how to create new tables for your data based on existing tables, and in
Chapter 4 we described how to add relationships between any new tables.

Protecting your data

A database can be protected with a password. This prevents unauthorized
users from successfully opening the database. As part of the password
protection process, the database is encrypted to prevent other software tools
from being used to examine the data.

To add or remove a password, you must access the database by using a
special sequence of steps that will open the database with the Open Exclusive
option.

Protect a database



1. Click the File tab, and select Open.

2. Select the file location.

3. Browse to locate the file.

4. In the Open popup window, select the file.

5. Change the option to Open Exclusive.

6. After the database opens, return to the File menu, and click Encrypt
With Password.

7. Type a password, type it again to verify it, and click OK.



8. Click OK on the warning message indicating that row-level locking will
be ignored.

Tip

To remove a database password, repeat these steps for the database. At step
6, the icon will be labeled Decrypt Database. To decrypt the database, you
need to have opened the database for exclusive use.

Tip

The warning displayed in step 8 means that although Access is designed to
allow multiple users to share data, because you have chosen to further
constrain the sharing of data with encryption Access can no longer share data



out to other users with the normal flexibility of locking individual rows, it
will lock pages of data. This is not normally a serious limitation in a database
with few users. In a database which was shared out to a larger number of
users you would probably not want to impose encryption because encryption
reduces performance and in addition, offers less flexibility in the method of
locking data.

Viewing object dependencies

The database has an internal map that tells Access where an object like a
table is used in queries, in relationships to other tables, and on forms and
reports. This feature enables the product to automatically modify the design
of dependent objects when you make changes in an object.

For example, say you have a table with a field called [Contact Name], and
you decide to remove the space and rename it [ContactName].

Now imagine that you have queries, forms, and reports that all refer to
[Contact Name]. However, because Access has a map of the dependencies, it
can automatically correct references to [Contact Name]. Note that there are
some limitations on these changes, relating to using the object name in more
complex expressions and calculations.

View an object’s dependencies

1. Select an object in the navigation pane.

2. Click the Database Tools tab.

3. Click Object Dependencies.

4. Click any of the objects on the right to display the object in Design
view.



5. Close the Object Dependencies pane, and open a table in Design view.
Then click Object Dependencies to see how this feature can be activated
when you have a table in Design view.
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Index

A note on the digital index

A link in an index entry is displayed as the section title in which that entry
appears. Because some sections have multiple index markers, it is not
unusual for an entry to have several links to the same section. Clicking on
any link will take you directly to the place in the text in which the marker
appears.

Symbols

[?] as symbol for filtering queries, Add a second set of criteria
[#] as symbol for filtering queries, Add a second set of criteria
* (asterisk)

adding all columns to query grid, Simplifying a problem with a query by
using other queries
as symbol for filtering queries, Add a second set of criteria
entering custom format string using, Formatting a field
using in UNION queries to select all fields, Adding two sets of query
results together
using to include all columns in table, Selecting individual columns from
one or more tables

[A-Z] (character pattern match), in filtering queries, Add a second set of
criteria
\ (backslash), as symbol for entering custom format string, Formatting a field
“ (double quote) marks, using in text fields, Save a filter as a query
! (exclamation mark), as symbol for entering custom format string,
Formatting a field
! (exclamation mark) symbol, reading code using, Link a form to a table or
query
+ (expansion symbol)

beside record selector, Deleting records
displaying subdatasheet using, Creating summary data for records



>= (greater than or equal to) symbol, in filtering queries, Add a second set of
criteria
> (greater than) symbol, in filtering queries, Add a second set of criteria
<= (less than or equal to) symbol, in filtering queries, Add a second set of
criteria
< (less than) symbol, in filtering queries, Add a second set of criteria
!= (not equal to) symbol in filtering queries, Add a second set of criteria
<> (not equal to) symbol in filtering queries, Add a second set of criteria
+ (plus) icon, on action bar, Working with the Datasheet view
# (pound sign)

as symbol for filtering queries, Add a second set of criteria
in date field of reports, Create a tabular report

; (semicolon), separating Input Mask sections, Make a field required and add
an input mask
(space) symbol, for entering custom format string, Formatting a field

A

“ABC” symbol for entering custom format string, Formatting a field
Access

query vs. SQL Server view, Adding a table template
starting, Starting Access

Access icon, from Import & Link group, Importing data and objects from
Access
Access Options popup window, Setting control defaults
action bar

+ (plus) icon on, Working with the Datasheet view
changing icons in, Launching a Web App
Edit icon on, Working with the List view
in browser, Launching a Web App
Save button on, Working with the List view

Action Catalog, Change other controls
action queries

adding data to tables with Append queries, Adding data to an existing
table with an Append query
adding filter criteria to Delete queries, Deleting data in tables with a



Delete query
changing data in tables with Update queries, Changing data in a table
with an Update query
creating tables with Make Table queries, Creating a table by using a
Make Table query
deleting data in tables with Delete queries, Deleting data in tables with a
Delete query
processing data with, Processing data with action queries
resetting Autonumbers with Append queries, Resetting an AutoNumber
with an Append query
running, Change data based on data in another table
updating columns based on expressions with Update queries, Updating a
column based on an expression
vs. select queries, Modifying data using queries

<Add A New Item> option, Working with the List view
Add A New Table link, Adding a blank table
Add Existing Fields, Avoiding blank pages
Add Existing Fields icon, Adding fields to a form in design view, Creating
check boxes, option buttons, and toggle buttons, Add a sort and group
Add Existing Fields option

in Tools section, Creating attachments, Working with tab controls
Add New Action field

IF command in, Validating data entered in controls
MessageBox action below, Validating data entered in controls

Add New View button
in blank view, Designing with a Datasheet view, Designing with a blank
view
in Datasheet view, Designing with a Datasheet view
in List Details view, Designing with a List Details view
in summary view, Designing with a summary view

Add Tables screen, Importing from an Access desktop database
adding

application part to tables, Creating a table by using application parts
blank tables, Adding a blank table
calculations with Expression Builder, Adding calculations with the
expression builder



data to tables with Append queries, Changing data in a table with an
Update query
fields

from table to table, Working with data parts in layout view
in List Details view, Remove fields
to continuous forms, Adding fields to a form in layout view
to form in layout view, Adding fields to a form in layout view
to forms in Design view, Adding fields to a form in design view
to predefined table, Showing the navigation pane

fields from Field List pane, Creating labels and text boxes
grouping and sorting in reports, Adding sorting and grouping on reports
input mask to a required field, Validate that data in a field is of the
correct type
message box stating macro has completed, Empty and populate a table
of data, Executing a saved import/export
primary key to tables, Create a table, Adding a primary key
relationships, Adding relationships
running sums to reports, Adding a running sum
sorting and grouping in reports, Adding sorting and grouping on reports
subforms to existing form in Design view, Adding a subform to an
existing form

administrating databases
about, Administrating a database
analyzing databases, Analyzing your database
compacting and repairing databases, Administrating a database
protecting data, Protecting your data
viewing object dependencies, View an object’s dependencies

Advanced Filter Options icon, Filtering combinations of choices with Filter
By Form
Advanced Filter Options menu, Filtering combinations of choices with
Advanced Filter/Sort
Advanced Filter/Sort option, Filtering combinations of choices with
Advanced Filter/Sort
After Update event, Build button for, Making controls change other controls
After Update macro command, Change other controls
Align icon, Alter the size and position of a control



Allow Additions property, Controlling editing and data entry in a form
Allow Deletions property, Controlling editing and data entry in a form
Allow Edits property, Controlling editing and data entry in a form
Allow Zero Length, Validate that data in a field is of the correct type
alternating rows, formatting in datasheets, Adjust row font
Always Prompt For A New Location option, Refreshing linked tables when
files are changed
Append Only field property, Recording changes to text and rich text
formatting
Append queries

adding data to tables with, Adding data to an existing table with an
Append query
adding only new data to tables, Updating a column based on an
expression
resetting Autonumbers with, Resetting an AutoNumber with an Append
query

application parts
creating, Add an application part
creating tables by using, Creating a table by using application parts

Apply Theme To All Matching Objects option, Applying Office themes
arithmetic comparison symbols used for filtering queries, Add a second set of
criteria
Arrange tab

in layout view of form layout tools tab, Creating a continuous form with
the multiple items template
in Rows And Columns group

to adjust layout, Add a field to a continuous form
to alter presentation of reports, Working with layout view, report
view, and Print Preview

asterisk (*)
adding all columns to query grid, Simplifying a problem with a query by
using other queries
as symbol for entering custom format string, Formatting a field
as symbol for filtering queries, Add a second set of criteria
using in UNION queries to select all fields, Adding two sets of query
results together



using to include all columns in table, Selecting individual columns from
one or more tables

Attachments data type
desktop database table, Create a blank desktop database
in Web Apps, Import an Access database
storing multiple documents on each record with, Creating bound and
unbound object frames

[Auto] option, setting Subdatasheet property to, Displaying related
information with a subdatasheet
Autocomplete controls

about, Working with the List view
displaying lookup data, Create a lookup

AutoNumber data type, desktop database table, Create a blank desktop
database
AutoNumber field, Adding a blank table, Creating a table in layout view
AutoNumber values, resetting, Resetting an AutoNumber with an Append
query
AVG calculations, in summary queries, Creating a summary calculation

B

Before Update event, Validating data entered in controls
BETWEEN keyword, in filtering queries, Add a second set of criteria
Blank Desktop Database icon, Creating a blank desktop database
blank desktop database, creating, Creating a blank desktop database
blank tables, adding, Adding a blank table
blank views, Web apps

about, Designing with a blank view
creating, Designing with a blank view

border styles, changing for controls, Creating lines and rectangles
bound controls, placing in report footer, Adding a running sum
bound forms, Using controls effectively
browser

action bar in, Launching a Web App
controls, Creating web browser controls
displaying Web App in, Finding your site and navigating to the team site



Open In Browser settings/actions option for views, Open, rename,
duplicate, or delete a view

Build button
for After Update event, Making controls change other controls
for Before Update event, Validating data entered in controls
for On Click event, Linking together forms
for Record Source property, Changing the data source for a form
for Row Source, Create a lookup based on values
in validation rule, Add a field validation rule and default

Builder icon, Adding calculations with the expression builder, Linking a form
to a query
buttons

Add New View
in blank view, Designing with a Datasheet view
in Datasheet view, Designing with a Datasheet view
in List Details view, Designing with a List Details view
in summary view, Designing with a summary view

Build
for After Update event, Making controls change other controls
for Before Update event, Validating data entered in controls
for On Click event, Linking together forms
for Record Source property, Changing the data source for a form
for Row Source, Create a lookup based on values
in validation rule, Add a field validation rule and default

command buttons, creating, Creating command buttons
Edit

in Datasheet view, Designing with a Datasheet view
in List Details view, Designing with a List Details view
in summary view, Designing with a summary view

Enable Content, Changing Access database options
Font, in Zoom box, Displaying more information with the Zoom box
Input Mask build, Validate that data in a field is of the correct type
options, Creating check boxes, option buttons, and toggle buttons
Run (macro), Processing data with action queries
Save button, on action bar, Working with the List view
Table, on Home ribbon, Importing from an Access desktop database



toggle, Creating check boxes, option buttons, and toggle buttons
By Group view, as label in view selector, Working with a summary view

C

Calculated data type
desktop database table, Create a blank desktop database
SQL Server, Change the design of a table

calculated fields, naming, Create an expression with the expression builder
calculations

adding with Expression Builder, Adding calculations with the
expression builder
supported in summary queries, Creating a summary calculation

Can Grow properties, Using the Can Grow and Can Shrink Properties,
Avoiding blank pages
Can Shrink properties, Using the Can Grow and Can Shrink Properties
Cascade Delete option

in Lookup Wizard, Create a lookup
changing

action bar icons, Launching a Web App
background color for controls, Setting control defaults
data in tables with Update queries, Changing data in a table with an
Update query
data source for forms, Changing the data source for a form
database options, Changing Access database options
Default View property from continuous forms to single form, Working
with form views
design of Web App tables, Changing the design of a table
field captions and descriptions, Change field captions and descriptions
layout options in reports, Create a tabular report
multiple controls, Using the Can Grow and Can Shrink Properties
name of Control Name property, Creating labels and text boxes
name of reports, Create a tabular report
name on Table Selector, Change a table icon
presentation of datasheets, Changing the datasheet presentation
presentation on report pages of controls, Altering the presentation of



controls on a page
Record Source property to SQL string, Changing the data source for a
form
rectangles, Creating lines and rectangles
size and position of controls in reports, Altering the presentation of
controls on a page
tabulated records to detail records in Web App summary view, Working
with a summary view

character pattern match ([A-Z]), in filtering queries, Add a second set of
criteria
check boxes

creating, Creating check boxes, option buttons, and toggle buttons
Disable All Trusted Locations, Change the default database options
Keep Me Signed In, Creating a custom Web App

child forms, naming, Create a parent/child form with a subform
child records

displaying parent records without, Display all parent records with and
without child records
finding unmatched, Joining tables to see unmatched or missing records
if not filtered moving through parent records, Altering link master and
link child fields

child reports, Create a parent/child report
Choose Builder dialog box, Linking together forms
choosing

Lookup data type, Creating a lookup/relationship
Office 365, Creating a custom Web App
table template, Adding a table template

color
adding to control areas, Creating lines and rectangles
changing for controls background, Setting control defaults

[color], symbol for entering custom format string, Formatting a field
Colors icon, Applying Office themes
column headings

in crosstab queries, Create a crosstab query
column title bar, filtering using, Remove a filter on a column
columns



managing report, Using labels and managing columns and rows
Columns presentation in reports, Using labels and managing columns and
rows
columns, datasheet

adjusting
fonts in, Adjust row font
width of, Adjusting column/row height and formatting

applying filter on, Filtering datasheet rows
automatically resizing, Adjusting column/row height and formatting
freezing and unfreezing, Hide and unhide columns
hiding and unhiding, Hide and unhide columns
in datasheets, Altering the presentation by ordering, hiding, and freezing
fields
ordering, Altering the presentation by ordering, hiding, and freezing
fields
removing

a sort, Sorting datasheet rows
filter on, Filtering datasheet rows

selecting multiple columns, Altering the presentation by ordering,
hiding, and freezing fields
selectng subset of, Selecting data to copy and paste
sorting, Sorting datasheet rows
undoing value using Esc key, Inserting and updating records

columns, forms
moving, Create a multiple items form

columns, table
deleting, Selecting individual columns from one or more tables
Group By, Creating a summary calculation
naming, Selecting individual columns from one or more tables
selecting all, Selecting all columns from a table
selecting individual, Selecting individual columns from one or more
tables
updating based on expressions, Updating a column based on an
expression

Combo Box Wizard, Creating combo boxes
combo boxes, Creating list boxes, Create a list box based on values



Command Button Wizard, Creating command buttons
command buttons, creating, Creating command buttons
commands, macro

After Update, Change other controls
ImportExport-Text, Disable Trusted Documents
ImportExportData, Disable Trusted Documents
ImportExportSpreadsheet, Disable Trusted Documents
ImportShare-PointList, Disable Trusted Documents
OpenForm, Linking together forms
OpenQuery, Linking together forms, Link a form to a table or query,
Processing data with action queries
OpenReport, Linking together forms
OpenTable, Linking together forms
Requery, Link a form to a table or query
RunSavedImportExport, Disable Trusted Documents
seeing extended list of commands in dropdown list, Making controls
change other controls
Set Warnings, Processing data with action queries, Empty and populate
a table of data

Compact & Repair icon, Compacting and repairing your database
compacting databases, Administrating a database
concatenating strings, Create an expression with the expression builder
conditional formatting

adding to reports, Adding conditional formatting
creating datasheet form with, Creating a datasheet form with conditional
formatting

Conditional Formatting Manager, Adding conditional formatting
Conditional Formatting Rules Manager popup window, Creating a datasheet
form with conditional formatting
continuous forms

adding fields in Design view, Add a field to a continuous form
adding fields in layout view, Add a field to a continuous form
creating with multiple items template, Creating a continuous form with
the multiple items template
Default View property to single form, Working with form views
dragging subform onto, Adding a subform to an existing form, Working



with tab controls
tabular layouts in, Working with control layouts, Adding fields to a form
in layout view, Add a field to a continuous form

Control Formatting group
Conditional Formatting icon in, Adding conditional formatting
Format tab in, Creating lines and rectangles

control morphing, Create an option button and toggle button
Control Name property, changing name of, Creating labels and text boxes
Control Source property, Creating labels and text boxes, Creating web
browser controls
Control Wizard, Creating option groups, Creating web browser controls
Control Wizards Option, turning off, Linking together forms
controls

altering report
presentation on report pages of, Altering the presentation of
controls on a page
size and position of, Altering the presentation of controls on a page

applying Office themes, Applying Office themes
bound and unbound, Using controls effectively
Can Grow and Can Shrink properties for, Using the Can Grow and Can
Shrink Properties
changing multiple, Using the Can Grow and Can Shrink Properties
creating

attachments, Creating attachments
bound object frames, Creating bound and unbound object frames
check boxes, Creating check boxes, option buttons, and toggle
buttons
combo boxes, Creating list boxes, Create a list box based on values,
Creating combo boxes
command buttons, Creating command buttons
hyperlinks, Creating hyperlinks
image controls, Creating image controls
labels and unbound text boxes, Creating labels and text boxes
list boxes, Creating list boxes
logos and titles, Creating logos and titles
option buttons, Creating check boxes, option buttons, and toggle



buttons
option groups, Creating option groups
toggle buttons, Creating check boxes, option buttons, and toggle
buttons
unbound controls, Creating check boxes, option buttons, and toggle
buttons
unbound object frames, Creating bound and unbound object
frames, Create an unbound object frame
web browser, Creating web browser controls

dragging from Field List pane, Working with tab controls
embedded, Creating image controls
making controls change other, Making controls change other controls
moving between sections in reports, Working with controls and sections
placing in report footer bound, Adding a running sum
resizing in List Details view, Designing with a List Details view
selecting multiple, Designing with a List Details view
setting defaults for, Setting control defaults
validating data entered in, Validating data entered in controls
working with layouts, Working with control layouts
working with tab, Working with tab controls

Controls toolbox
Control Wizard activated from, Creating web browser controls
hyperlink icon in, Creating hyperlinks
image icon in, Creating image controls
list box icon, Creating list boxes
option button on, Creating check boxes, option buttons, and toggle
buttons
option group icon in, Creating option groups
rectangle icon on, Creating lines and rectangles
tab control in, Working with tab controls
unbound object frame option in, Create an unbound object frame

copying, selecting data for, Selecting data to copy and paste
Create Relationship popup window, Creating a table by using application
parts
Create Reports menu choice, Working with reports
creating



application parts, Add an application part
attachment control, Creating attachments
blank desktop database, Creating a blank desktop database
check boxes, Creating check boxes, option buttons, and toggle buttons
combo boxes, Creating list boxes, Create a list box based on values,
Creating combo boxes
command buttons, Creating command buttons
continuous forms with multiple items template, Creating a continuous
form with the multiple items template
crosstab queries, Creating a crosstab query with the Query Wizard
custom Web Apps, Creating a custom Web App
datasheet form with conditional formatting, Creating a datasheet form
with conditional formatting
embedded macro to open forms, Linking together forms
expressions with, Adding calculations with the expression builder
hyperlinks, Creating hyperlinks
image controls, Creating image controls
in layout view data parts, Create a new data part
indexes in tables, Improving performance by indexing data
labels and unbound text boxes, Creating labels and text boxes
lines, Creating lines and rectangles
List Details view in Web Apps, Designing with a List Details view
logos and titles, Creating logos and titles
lookups based on values, Create a lookup based on values
multiple table tabular reports, Creating a tabular report with multiple
tables
option buttons, Creating check boxes, option buttons, and toggle buttons
option groups, Creating option groups
parent-child forms, Creating a parent/child form with the Form Wizard
parent/child reports, Creating a parent/child report
queries to combine data from tables and queries, Create a crosstab query
relationships, Creating relationships by using the Lookup Wizard,
Adding relationships
report database for Web Apps, Working with reports
required table fields, Validate that data in a field is of the correct type
single record forms, Creating a single record form with the Form Wizard



split forms, Creating a split form
summary calculations, Creating a summary calculation
summary data for records, Creating summary data for records
table validation, Comparing field values by using table validation
tables in layout view, Creating a table in layout view
tables using Make Table queries, Creating a table by using a Make Table
query
titles and logos, Creating logos and titles
toggle buttons, Creating check boxes, option buttons, and toggle buttons
two-level navigation forms, Organizing your database with navigation
forms
Web App templates, Creating a Web App using a template
web browser controls, Creating web browser controls

criteria, query
filtering using multiple, Filtering by single and multiple combinations of
choices
symbols used in, Add a second set of criteria

crosstab queries, creating, Creating a crosstab query with the Query Wizard
Crosstab Query Wizard, Creating a crosstab query with the Query Wizard
Ctrl key, selecting multiple controls using, Remove fields
Currency data type

desktop database table, Create a blank desktop database
SQL Server, Change the design of a table

custom Web Apps, What’s new in Access 2013?
(see also Web Apps)
about, Creating a custom Web App
adding blank table, Adding a blank table
adding table template, Adding a table template
AutoNumber field as primary key, Adding a blank table
creating custom, Creating a custom Web App
creating templates, Creating a Web App using a template
Datasheet view in, Working with the Datasheet view
displaying in browser, Finding your site and navigating to the team site
displaying list of templates, Adding a table template
finding team site, Finding your site and navigating to the team site
importing data from desktop database into, Importing from an Access



desktop database
launching, Launching a Web App
List Details view in, Working with the List view
navigating to team site, Finding your site and navigating to the team site
showing navigation pane, Showing the navigation pane
summary view in, Working with a summary view

D

data, Adding only new data that is not already in a table
(see also data, Web Apps)
adding to tables only new, Adding only new data that is not already in a
table
adding to tables using Append queries, Adding data to an existing table
with an Append query
deleting in tables, Deleting data in tables with a Delete query
displaying in queries in Web Apps, Creating a query
exchanging

about, Exchanging data
exporting as PDF documents, Exporting data as PDF documents
exporting to Excel, Exporting data to Excel
importing from Access databases, Importing data and objects from
Access
importing from Excel, Importing data from Excel
importing from text files, Importing data from text files using
specifications
linking to data in Excel, Linking to data in Excel
linking to outside databases, Linking to data in Access
refreshing linked tables, Refreshing linked tables when files are
changed
working with saved imports and exports, Working with saved
imports and exports

from parent record in subreports, Creating a parent/child report
handling word wrap in, Using the Can Grow and Can Shrink Properties
indexing, Improving performance by indexing data
managing in reports page breaks and, Managing data and page breaks



presentation of
in forms, Improving presentations with forms
in queries, Selecting data using queries

processing with action queries, Processing data with action queries
prompting with parameters to filter, Prompting to filter data with
parameters
protecting, Protecting your data
selecting all displayed data, Selecting data to copy and paste
selecting area of, Select an area of data
selecting to copy and paste, Selecting data to copy and paste
showing in reports, Using labels and managing columns and rows

Data charm
in blank view, Designing with a blank view
in summary view, Create a summary view

data parts, working in layout view with, Working with data parts in layout
view
Data popup windows

in blank view, Designing with a blank view
in creating summary view, Create a summary view

Data Type drop-down arrow, Changing the design of a table
Data Type drop-down box

in Import Spreadsheet Wizard, Import data from Excel
in Import Text Wizard, Import data from a text file

data types
Attachments

desktop database table, Create a blank desktop database
storing multiple documents on each record with, Creating bound
and unbound object frames

AutoNumber, desktop database table, Create a blank desktop database
Calculated

desktop database table, Create a blank desktop database
SQL Server, Change the design of a table

Currency
desktop database table, Create a blank desktop database
SQL Server, Change the design of a table

Date/Time



desktop database table, Create a blank desktop database
SQL Server, Change the design of a table

excluded from data imports to Web App, Import an Access database
Hyperlink

desktop database table, Create a blank desktop database
SQL Server, Change the design of a table

Image, SQL Server, Change the design of a table
Long Text

Append Only and rich text for, Recording changes to text and rich
text formatting
desktop database table, Create a blank desktop database
in UNION queries, Adding two sets of query results together
SQL Server, Change the design of a table

Lookup, SQL Server, Change the design of a table
not permitted in Union queries, Adding two sets of query results
together
Number

desktop database table, Create a blank desktop database
SQL Server, Change the design of a table

OLE Objects
desktop database table, Create a blank desktop database
displaying, Creating bound and unbound object frames
dragging into Field List pane, Creating bound and unbound object
frames
in UNION queries, Adding two sets of query results together
in Web Apps, Import an Access database

Short Text
desktop database table, Create a blank desktop database, Change
field captions and descriptions
SQL Server, Change the design of a table

validating in fields, Validate that data in a field is of the correct type
Yes/No

desktop database table, Create a blank desktop database
SQL Server, Change the design of a table

data, Web Apps
entering



about, Launching a Web App
in Datasheet view, Working with the Datasheet view
into tables, Showing the navigation pane

importing from desktop database, Importing from an Access desktop
database
presentations, Working with the List view

Database Documenter, Analyzing your database
Database Tools tab, Object Dependencies option from, View an object’s
dependencies
databases

administrating
about, Administrating a database
analyzing databases, Analyzing your database
compacting and repairing, Administrating a database
protecting data, Protecting your data
removing passwords, Protect a database
viewing object dependencies, View an object’s dependencies

changing options, Changing Access database options
creating report database for Web Apps, Working with reports
importing data and objects from Access, Importing data and objects
from Access
linking to outside, Linking to data in Access
refreshing linked tables from, Refreshing linked tables when files are
changed

datasheet form, creating with conditional formatting, Creating a datasheet
form with conditional formatting
Datasheet Formatting box, Adjust row font
Datasheet view

checking data in, Adding data to an existing table with an Append query
More Forms datasheet template displaying forms in, Creating a
datasheet form with conditional formatting
viewing forms in Design view and, Create a datasheet form
viewing parameterized query in, Prompting to filter data with parameters

Datasheet view, Web App
about, Working with the Datasheet view, Modifying a Web App,
Designing with a Datasheet view



creating, Designing with a Datasheet view
designing with, Designing with a Datasheet view
editing records in, Designing with a Datasheet view
formatting fields in, Format a field
making multiple filtering choices in, Working with the Datasheet view
recording changes in, Launching a Web App

datasheets
about, Working with data in datasheets, Altering the presentation by
ordering, hiding, and freezing fields
changing options for, Changing the datasheet presentation
columns

adjusting fonts in, Adjust row font
adjusting width of, Adjusting column/row height and formatting
applying and removing, Filtering datasheet rows
automatically resizing, Adjusting column/row height and
formatting
freezing and unfreezing, Hide and unhide columns
hiding and unhiding, Hide and unhide columns
ordering, Altering the presentation by ordering, hiding, and
freezing fields
selecting subset of, Selecting data to copy and paste
sorting, Sorting datasheet rows

creating summary data for records, Creating summary data for records
displaying information with Zoom box, Displaying more information
with the Zoom box
displaying totals for datasheets, Creating summary data for records
filtering

applying Save As Query option, Save a filter as a query
rows in, Filtering datasheet rows
using Advanced Filter/Sort options, Filtering combinations of
choices with Advanced Filter/Sort
using Filter By Form option, Filtering combinations of choices with
Filter By Form

records
deleting, Deleting records
inserting and updating, Inserting and updating records



moving between, Moving between records and using Find And
Replace

rows
adjusting fonts in, Adjust row font
adjusting height of, Adjusting column/row height and formatting

selecting data to copy and paste, Selecting data to copy and paste
sorting order of fields in, Sorting datasheet rows
sorting rows, Sorting datasheet rows
subdatasheets

displaying, Creating summary data for records
displaying related information with, Displaying related information
with a subdatasheet

using Find And Replace, Moving between records and using Find And
Replace

date field, # symbols in, Create a tabular report
Date/Time data type

desktop database table, Create a blank desktop database
SQL Server, Change the design of a table

Delete queries, Deleting data in tables with a Delete query
adding filter criteria to, Deleting data in tables with a Delete query

deleting
action bar icons, Launching a Web App
blank pages in reports, Avoiding blank pages
columns in tables, Selecting individual columns from one or more tables
data in tables, Deleting data in tables with a Delete query
fields in List Details view, Remove fields
records, Deleting records
relationships, Deleting relationships
views using settings/actions options, Open, rename, duplicate, or delete
a view

Delimited text option, Importing data from text files using specifications,
Import data from a text file
Design tab

Add Existing Fields icon from, Adding fields to a form in design view
in layout view of form layout tools tab, Creating a continuous form with
the multiple items template



Modify Lookups icon from, Creating a lookup/relationship
on Form Design Tools ribbon, Creating labels and text boxes
Property Sheet icon from, Changing the data source for a form
Show Table icon on, Sort by selected columns

Design view
adding

fields to forms in, Adding fields to a form in design view
subform in, Adding a subform to an existing form

creating tables in, Creating a table in design view
defining primary key in, Adding a primary key
displaying reports in, Create a tabular report
returning from datasheet to, Selecting all columns from a table
selecting from Navigation Pane, Altering the presentation of controls on
a page
switching from changing settings/actions to, Open, rename, duplicate, or
delete a view
using build button to enter query design mode, Changing the data source
for a form
viewing forms in Datasheet view and, Create a datasheet form
working with control layouts in, Working with control layouts

Design View option, in View icon, Selecting all columns from a table
desktop databases

about, Creating a desktop database
importing data and objects from Access, Importing data and objects
from Access
importing data to Web Apps from, Importing from an Access desktop
database

desktop, returning quickly to, Starting Access
detail records, changing from tabulated records in Web App summary view,
Working with a summary view
Disable All Trusted Locations check box, Change the default database
options
Disable Trusted Documents check box, Enabling macro commands and
disabling Trusted Documents
Documenter tool, Analyzing your database
domain name, entering URL for Office 365, Creating a custom Web App



double quote (“) marks, using in text fields, Save a filter as a query
Double, for numbers, Create a table
duplicate values

eliminating, Eliminating duplicate values
suppressing, Working with controls and sections

duplicating, views using settings/actions options, Open, rename, duplicate, or
delete a view

E

Edit button
in blank view, Designing with a blank view
in Datasheet view, Designing with a Datasheet view
in List Details view, Designing with a List Details view
in summary view, Designing with a summary view

Edit icon
in Table Selector, Showing the navigation pane
on action bar, Working with the List view

Edit Relationships popup window, Adding relationships
Edit Table menu choice, from Datasheet view, Changing the design of a table
Edit Table option, changing table design using, Open, rename, duplicate, or
delete a view
Enable Content button, Changing Access database options
Enabled property (Data Properties), Controlling editing and data entry in a
form
Encrypt With Password option, Protecting your data
Esc key

undoing column value using, Inserting and updating records
Event tab, from Property Sheet pane, Linking together forms
Excel

exporting data to, Exporting data to Excel
importing data from, Importing data from Excel
linking to data in, Linking to data in Excel
refreshing linked worksheets from, Refreshing linked tables when files
are changed

exclamation mark (!) symbol, reading code using, Link a form to a table or



query
exclamation mark (!), as symbol for entering custom format string,
Formatting a field
expansion symbol (+)

beside record selector, Deleting records
displaying subdatasheet using, Creating summary data for records

explicit values
performing updates based on, Changing data in a table with an Update
query

exporting data
as PDF documents, Exporting data as PDF documents
in XMS format, Exporting data as PDF documents
to Excel, Exporting data to Excel
working with saved data, Working with saved imports and exports

Expression Builder
adding calculations with, Adding calculations with the expression
builder
popup window, Linking a form to a query

Expression Builder dialog box, Adding calculations with the expression
builder
Expression fields, entering data in, Change other controls
expressions

adding to NULL to expressions, Adding calculations with the expression
builder
updating columns based on, Updating a column based on an expression
working with complex expressions using Zoom box, Adding
calculations with the expression builder

External Data tab
Access icon from, Importing data and objects from Access
Excel icon from, Linking to data in Excel, Exporting data to Excel
Linked Table Manager icon from, Refreshing linked tables when files
are changed, Working with saved imports and exports
Text File icon from, Importing data from text files using specifications

F



field captions and descriptions, changing, Change field captions and
descriptions
Field List

editing view and displaying, Open, rename, duplicate, or delete a view
using dragging action to add fields, Remove fields

Field List pane
adding fields from, Creating labels and text boxes
creating hyperlink from, Creating hyperlinks
dragging attachment to, Creating attachments
dragging controls from, Working with tab controls
dragging OLE Objects data type into, Creating bound and unbound
object frames
Yes/No field in, Creating check boxes, option buttons, and toggle
buttons

Field Properties section, Lookup tab in, Create a lookup based on values
fields

adding
from table to table, Working with data parts in layout view
in List Details view, Remove fields
to form in layout view, Adding fields to a form in layout view
to forms in Design view, Adding fields to a form in design view
to predefined table, Showing the navigation pane

altering link master and link child, Altering link master and link child
fields
creating required, Validate that data in a field is of the correct type
defining lookups on, Create a lookup based on values
deleting, in List Details view, Remove fields
entering custom format string, Formatting a field
formatting, Formatting a field
ID, Adding a blank table
in datasheets, Altering the presentation by ordering, hiding, and freezing
fields
Memo, Changing the design of a table, Change the design of a table
naming calculated fields, Create an expression with the expression
builder
naming query, Selecting individual columns from one or more tables



sorting order in datasheets of, Sorting datasheet rows
SQL Server data type, Change the design of a table
Text, Changing the design of a table
using Lookup Wizard in choosing, Creating relationships by using the
Lookup Wizard
validating data types in, Validate that data in a field is of the correct type
Yes/No fields, creating check boxes, option buttons, and toggle buttons
for, Creating check boxes, option buttons, and toggle buttons

Filter By Form option, Filtering combinations of choices with Filter By Form
filtering

By Group view as label in view selector, Working with a summary view
data and prompting with parameters, Prompting to filter data with
parameters
datasheet rows, Filtering datasheet rows
making multiple choices in datasheet view, Working with the Datasheet
view
queries using multiple criteria in, Filtering by single and multiple
combinations of choices
using Advanced Filter/Sort options, Filtering combinations of choices
with Advanced Filter/Sort

Find And Replace, using, Moving between records and using Find And
Replace
Find Unmatched Query option, in Query Wizard, Joining tables to see
unmatched or missing records
Fixed Width text option, Importing data from text files using specifications,
Import data from a text file
Font button, in Zoom box, Displaying more information with the Zoom box
fonts

adjusting datasheet row and column, Adjust row font
resizing in Zoom box, Displaying more information with the Zoom box

Fonts icon, Applying Office themes
footers, placing bound controls in report, Adding a running sum
Force New Page property, Managing data and page breaks
foreign key fields, adding indexes to, Improving performance by indexing
data
Form Design Tools Format tab, Setting control defaults



Form Design Tools ribbon, Design tab on, Creating labels and text boxes
Form Layout Tools tab, Adding fields to a form in layout view
Form Name drop-down list, Create an embedded macro to open a form
Form Wizard

creating parent-child forms with, Creating a parent/child form with the
Form Wizard
creating single record forms with, Creating a single record form with the
Form Wizard
Linked Forms option from, Creating a parent/child form with the Form
Wizard

Format tab
in Control Formatting group, Creating lines and rectangles
in layout view of form layout tools tab, Creating a continuous form with
the multiple items template

formatting
adding to reports conditional, Adding conditional formatting
fields, Formatting a field
fields in Web App Datasheet view, Format a field
icon in Datasheet view, Format a field
rows in datasheets, Adjust row font
Table Selector icons, Change a table icon

forms
about layout view in, Creating a table in layout view
adding fields to form in layout view, Adding fields to a form in layout
view
adding fields to forms in Design view, Adding fields to a form in design
view
altering link master and link child fields, Altering link master and link
child fields
changing data source for, Changing the data source for a form
controlling editing and data entry in, Controlling editing and data entry
in a form
creating

datasheet form with conditional formatting, Creating a datasheet
form with conditional formatting
embedded macro to open, Linking together forms



parent-child forms, Creating a parent/child form with the Form
Wizard
split, Creating a split form
tabs in, Organizing your database with navigation forms
two-level navigation, Organizing your database with navigation
forms
when defining lookups on fields, Create a lookup based on values

labels becoming detached from single, Add a field to a continuous form
linking to queries or tables, Linking a form to a query
moving columns, Create a multiple items form
organizing database with navigation forms, Organizing your database
with navigation forms
presentation of data in, Improving presentations with forms
single record (see single record forms (subforms))
validating data entered in controls, Validating data entered in controls
vs. reports, Creating a tabular report with multiple tables
vs. views, Adding a table template
working with control layouts, Working with control layouts

Forms group
More Forms drop-down arrow in, Creating a continuous form with the
multiple items template
Navigation drop-down arrow in, Organizing your database with
navigation forms

freezing columns, Hide and unhide columns

G

graphics, using on many forms, Create an unbound object frame
greater than (>) symbol, in filtering queries, Add a second set of criteria
greater than or equal to (>=) symbol, in filtering queries, Add a second set of
criteria
Group & Sort icon, Adding sorting and grouping on reports
Group By column, Creating a summary calculation
Grouping & Totals group, Adding sorting and grouping on reports



H

Hide Duplicates property, Working with controls and sections
hiding columns, Hide and unhide columns
Home ribbon

Advanced Query, Creating a query
Table button, Importing from an Access desktop database

Hyperlink data type
desktop database table, Create a blank desktop database
SQL Server, Change the design of a table

hyperlinks
creating, Creating hyperlinks
creating navigation interface using, Creating hyperlinks

I

I Will Type In The Values That I Want option, in List Box Wizard, Creating
list boxes
icons

Access, Importing data and objects from Access
Add Existing Fields, Adding fields to a form in design view, Adding
fields to a form in layout view, Add a sort and group
Advanced Filter Options, Filtering combinations of choices with Filter
By Form
Align, Alter the size and position of a control
Blank Desktop Database, Creating a blank desktop database
Builder, Adding calculations with the expression builder, Linking a form
to a query
Colors, Applying Office themes
Column, Add a columns presentation
Compact & Repair, Compacting and repairing your database
Conditional Formatting, Adding conditional formatting
Data

in blank view, Designing with a blank view
in summary view, Create a summary view



Edit
in action bar, Working with the List view
in Table Selector, Showing the navigation pane

Excel, Importing data from Excel, Linking to data in Excel, Exporting
data to Excel
Fonts, Applying Office themes
formatting, in Datasheet view, Format a field
Group & Sort, Adding sorting and grouping on reports
hyperlink, Creating hyperlinks
image, Creating image controls
Insert Image, Create an image with the Image Gallery
Launch App, Launching a Web App
line control, Creating lines and rectangles
Linked Table Manager, Refreshing linked tables when files are changed
list box, Creating list boxes
Logo, Creating logos and titles
Modify Lookups, Creating a lookup/relationship
Navigation Pane, Showing the navigation pane
New Blank Record, Inserting and updating records
option group, Creating option groups
Parameters, Prompting to filter data with parameters
PDF, Exporting data as PDF documents
plus (+), on action bar, Working with the Datasheet view
primary key, Adding a primary key
Property Sheet, Eliminating duplicate values, Changing the data source
for a form, Creating bound and unbound object frames
rectangle, Creating lines and rectangles
Report, Working with layout view, report view, and Print Preview
Report Wizard, Creating a tabular report with multiple tables
Save, Adding a blank table
Saved Imports, Working with saved imports and exports
Select Column, Create a multiple items form
Settings/Actions, Showing the navigation pane
shape fill, Creating lines and rectangles
shape outline, Creating lines and rectangles
Show Table, Sort by selected columns



Single Step, using with macros, Empty and populate a table of data
Size/Space, Alter the size and position of a control
Text File, Importing data from text files using specifications
Themes, Applying Office themes
Title, Creating logos and titles
Totals, Creating summary data for records
Undo, Inserting and updating records
View, Design View option in, Selecting all columns from a table, Create
a tabular report
XPS, Exporting data as PDF documents

ID field
about, Adding a blank table
in desktop tables, Creating a table in layout view, Creating a table by
using application parts
naming, Adding a blank table

IF command, in Add New Action field, Validating data entered in controls
IIF function, in Expression Builder, Adding calculations with the expression
builder
image controls, creating, Creating image controls
Image data type, SQL Server, Change the design of a table
Image Gallery, Create an unbound object frame, Create an image with the
Image Gallery
images, dragging attachment into, Creating attachments
Import & Link group

Access icon in, Importing data and objects from Access
Excel icon in, Importing data from Excel, Linking to data in Excel
Linked Table Manager icon in, Refreshing linked tables when files are
changed, Working with saved imports and exports
Text File icon in, Importing data from text files using specifications

Import Objects popup window, Import data and objects from an Access
database
import specifications, Import data from a text file
Import Spreadsheet Wizard, Importing data from Excel
Import Text Wizard, Importing data from text files using specifications
import/export processes, executing saved, Executing a saved import/export
ImportExport-Text macro command, Disable Trusted Documents



ImportExportData macro command, Disable Trusted Documents
ImportExportSpreadsheet macro command, Disable Trusted Documents
importing data

from Access databases, Importing data and objects from Access
from Excel, Importing data from Excel
from text files using specifications, Importing data from text files using
specifications
to Web Apps from desktop database, Importing from an Access desktop
database
working with saved data, Working with saved imports and exports

importing objects
from Access databases, Importing data and objects from Access
with same name, Import data and objects from an Access database

ImportShare-PointList macro command, Disable Trusted Documents
IN keyword, in filtering queries, Add a second set of criteria
Indexes popup window, Improving performance by indexing data
indexing data, Improving performance by indexing data
information, displaying with Zoom box, Displaying more information with
the Zoom box
INNER JOINs, Resolving ambiguous outer joins
input mask

adding to a required field, Validate that data in a field is of the correct
type

Input Mask build button, Validate that data in a field is of the correct type
Insert Hyperlink popup window, Creating web browser controls
Insert Image icon, Create an image with the Image Gallery
inserting records in datasheets, Inserting and updating records
InStr functions, Updating a column based on an expression
IntelliSense help

in entering data in Expression fields, Change other controls
in Where Condition box, Create an embedded macro to open a form

J

joining tables
about, Sort by selected columns



INNER JOINs, Resolving ambiguous outer joins
resolving ambiguous outer joins, Resolving ambiguous outer joins
resolving problems with mixed joins, Creating an additional query to
resolve a problem with mixed joins
using fields, Simplifying a problem with a query by using other queries

JOINs, Resolving ambiguous outer joins

K

Keep Me Signed In check box, Creating a custom Web App
Keep Together property, Keep results together on the same page
Keep Whole Group Together On One Page option, Add a sort and group

L

label controls, putting title in, Creating logos and titles
Label Wizard, Using labels and managing columns and rows
labels

becoming detached from single form, Add a field to a continuous form
moving from page header, Move controls between sections
using in reports, Using labels and managing columns and rows

Launch App icon, Launching a Web App
layout options, changing in reports, Create a tabular report
layout view

about, Creating a table in layout view
adding fields to form in, Adding fields to a form in layout view
creating tables in, Creating a table in layout view
form layout tools tab in, Creating a continuous form with the multiple
items template
in reports, Working with layout view, report view, and Print Preview
working with control layouts in, Working with control layouts
working with data parts in, Working with data parts in layout view

layouts, controlling, Showing the navigation pane
LCASE functions, Updating a column based on an expression
LEFT functions, Updating a column based on an expression
less than (<) symbol, in filtering queries, Add a second set of criteria



less than or equal to (<=) symbol, in filtering queries, Add a second set of
criteria
like keyword, in matching text fields, Filtering by single and multiple
combinations of choices
line control icon, Creating lines and rectangles
lines, creating, Creating lines and rectangles
Link Master Fields, in Report Properties pane, Creating a parent/child report
link master, altering link child fields and, Altering link master and link child
fields
Link To The Data Source By Creating A Linked Table option, Linking to
data in Access
Linked Forms option, from Form Wizard, Creating a parent/child form with
the Form Wizard
Linked Table Manager icon, Refreshing linked tables when files are changed
linked tables, refreshing, Refreshing linked tables when files are changed
linking

forms to queries or tables, Linking a form to a query
to Access table, Linking to data in Excel
to data in Excel, Linking to data in Excel
to outside databases, Linking to data in Access
together forms, Linking together forms

list box icon, Creating list boxes
List Box Wizard, Creating list boxes
list boxes, creating, Creating list boxes
List Details view, Web App

about, Working with the List view, Designing with a List Details view
adding fields in, Remove fields
creating, Designing with a List Details view
deleting fields in, Remove fields
in Web Apps, Modifying a Web App

Locked property (Data Properties), Controlling editing and data entry in a
form
Logo icon, Creating logos and titles
Long Integer, for numbers, Create a table
Long Text data type

Append Only and rich text for, Recording changes to text and rich text



formatting
desktop database table, Create a blank desktop database
in UNION queries, Adding two sets of query results together
SQL Server, Change the design of a table

Lookup data type
choosing, Creating a lookup/relationship
SQL Server, Change the design of a table

lookup fields, using, Creating relationships by using the Lookup Wizard
Lookup tab, in Field Properties section, Create a lookup based on values
Lookup Wizard

about, Creating relationships by using the Lookup Wizard
choosing Cascade Delete option in, Create a lookup
choosing fields using, Creating relationships by using the Lookup
Wizard
creating relationships using, Creating relationships by using the Lookup
Wizard
lower part of screen, Creating a lookup/relationship

lookups
creating based on values, Create a lookup based on values
creating using Lookup Wizard, Creating relationships by using the
Lookup Wizard
storing multiple values in, Add an application part

lookups, Web App
about, Modifying a Web App
creating, Creating a lookup/relationship

M

Macro Editing Tool, opening from On Click event, Creating command
buttons
Macro Tools Design tab, Change other controls
macros

about, Introducing the power of macros
adding macro has completed message box, Executing a saved
import/export
commands for (see commands, macro)



enabling, Changing Access database options, Enabling macro
commands and disabling Trusted Documents
for executing saved import/export processes, Executing a saved
import/export
for linking forms to queries or tables, Linking a form to a query
for linking together forms, Linking together forms
for On Click event, Creating command buttons
for operating in Trusted Documents, Disable Trusted Documents
making controls change other controls, Making controls change other
controls
processing data with action queries, Processing data with action queries
running, Executing a saved import/export
seeing extended list of commands in dropdown list, Making controls
change other controls
validating data entered in controls, Validating data entered in controls

Make Table queries, creating tables with, Creating a table by using a Make
Table query
Manage Data Tasks popup window, Working with saved imports and exports
MAX calculations, in summary queries, Creating a summary calculation
Memo field, Changing the design of a table
MessageBox action

adding stating macro has completed, Empty and populate a table of data,
Executing a saved import/export
below Add New Action field, Validating data entered in controls

Microsoft Excel
exporting data to, Exporting data to Excel
importing data from, Importing data from Excel
linking to data in, Linking to data in Excel
refreshing linked worksheets from, Refreshing linked tables when files
are changed

Microsoft Trustworthy Computing, website for, Enabling macro commands
and disabling Trusted Documents
MID functions, Updating a column based on an expression
MIN calculations, in summary queries, Creating a summary calculation
mixed joins, resolving problems with, Creating an additional query to resolve
a problem with mixed joins



Modify Lookups icon, Creating a lookup/relationship
More Forms datasheet template, Creating a datasheet form with conditional
formatting
More Forms drop-down arrow, in Forms group, Creating a continuous form
with the multiple items template

N

naming
calculated fields, Create an expression with the expression builder
fields in queries, Selecting individual columns from one or more tables
ID field, Adding a blank table
parent and child forms, Create a parent/child form with a subform
tables, Creating a table in design view

Navigate Up menu choice, Finding your site and navigating to the team site
Navigation drop-down arrow, in Forms group, Organizing your database with
navigation forms
navigation forms, organizing database with, Organizing your database with
navigation forms
Navigation Pane

changing design of Web App tables from, Changing the design of a table
macros running from, Executing a saved import/export
selecting Design View from, Altering the presentation of controls on a
page
selecting tables from, Showing the navigation pane
showing, Showing the navigation pane

navigation pane icon, Showing the navigation pane
New Blank Record icon, Inserting and updating records
New Formatting Rule popup window, Create a datasheet form
New Query popup window, Crosstab Query Wizard in, Creating a crosstab
query with the Query Wizard
New Rule, in Conditional Formatting Manager, Adding conditional
formatting
not equal to (<> or !=) symbol in filtering queries, Add a second set of
criteria
NULLs (no values)



adding to expressions, Adding calculations with the expression builder
eliminating, Eliminating duplicate values
finction to convert to value, Adding calculations with the expression
builder
primary key and, Adding a primary key

Number data type
desktop database table, Create a blank desktop database
SQL Server, Change the design of a table

numeric key field, width of, Creating a table by using application parts
nz function, in Expression Builder, Adding calculations with the expression
builder

O

Object Dependencies option, from Database Tools tab, View an object’s
dependencies
object dependencies, viewing, View an object’s dependencies
object frames creating unbound, Creating bound and unbound object frames,
Create an unbound object frame
objects, importing from Access databases, Importing data and objects from
Access
Office 365

choosing, Creating a custom Web App
entering domain name URL, Creating a custom Web App
finding team site from account area in, Finding your site and navigating
to the team site
signing into, Creating a custom Web App

Office themes, applying to controls, Applying Office themes
OLE Objects data type

desktop database table, Create a blank desktop database
displaying, Creating bound and unbound object frames
dragging into Field List pane, Creating bound and unbound object
frames
in UNION queries, Adding two sets of query results together
in Web Apps, Import an Access database

On Click event, Creating command buttons, Linking together forms



Open Exclusive option, Protecting your data
OpenForm macro command, Linking together forms
opening

views using settings/actions options, Open, rename, duplicate, or delete
a view
Web App in Access from team site, Finding your site and navigating to
the team site

OpenQuery macro command, Linking together forms, Link a form to a table
or query, Processing data with action queries
OpenReport macro command, Linking together forms
OpenTable macro command, Linking together forms
option buttons, creating, Creating check boxes, option buttons, and toggle
buttons
option group icon, Creating option groups
Option Group Wizard, Creating option groups
option groups, creating, Creating option groups
Option Value property, Create an option group
Options menu item, changing datasheet options using, Changing the
datasheet presentation
Other Picture Type property options, on Picture Type property, Creating
image controls
outer joins, resolving ambiguous, Resolving ambiguous outer joins

P

Page Break control, Managing data and page breaks
page breaks, managing in reports, Managing data and page breaks
Page Layout group, Add a columns presentation
Page Setup popup window, Add a columns presentation
pages, avoiding in reports blank, Avoiding blank pages
Parameters icon, Prompting to filter data with parameters
parent forms

naming, Create a parent/child form with a subform
parent records

child records if not filtered moving through, Altering link master and
link child fields



displaying without child records, Display all parent records with and
without child records

parent/child forms, creating, Creating a parent/child form with the Form
Wizard
parent/child reports, creating, Creating a parent/child report
passwords

Encrypt With Password option, Protecting your data
removing database, Protect a database

pasting, selecting data for copying and, Selecting data to copy and paste
PDF documents, exporting data as, Exporting data as PDF documents
performance of databases, analyzing, Analyzing your database
PgUp and PgDn keys, in moving between records, Moving between records
and using Find And Replace
Picture popup window, Creating image controls
Picture Type property, Creating image controls
plus (+) icon, on action bar, Working with the Datasheet view
pound (#)

as symbol for filtering queries, Add a second set of criteria
in date field of reports, Create a tabular report

predefined tables, adding fields to, Showing the navigation pane
presentation

of data in forms, Improving presentations with forms
of data in queries, Selecting data using queries
of datasheets, changing, Changing the datasheet presentation

presentation defaults, for controls, Setting control defaults
presentation views of data, in Web Apps, Working with the List view
primary key

adding to tables, Create a table, Adding a primary key
AutoNumber field as, Adding a blank table, Creating a table in layout
view

Print Preview, Create a tabular report, Working with layout view, report
view, and Print Preview
PrintPreview vs. ReportView, Preparing data to print using reports
Property Sheet icon, Eliminating duplicate values, Changing the data source
for a form, Creating bound and unbound object frames
Property Sheet option, in Tools section, Creating web browser controls



Property Sheet pane, Build button from, Linking together forms

Q

queries
about, Creating a query, Selecting data using queries
action

adding data to tables with, Adding data to an existing table with an
Append query
adding only new data to tables, Updating a column based on an
expression
changing data in tables with, Changing data in a table with an
Update query
creating tables with, Creating a table by using a Make Table query
deleting data in tables with, Deleting data in tables with a Delete
query
resetting Autonumbers with, Resetting an AutoNumber with an
Append query
running, Change data based on data in another table
updating columns based on expressions with, Updating a column
based on an expression
vs. select queries, Modifying data using queries

adding calculations with Expression Builder, Adding calculations with
the expression builder
adding together two, Adding two sets of query results together
Append

adding data to tables with, Adding data to an existing table with an
Append query
adding only new data to tables with, Adding only new data that is
not already in a table
resetting Autonumbers with, Resetting an AutoNumber with an
Append query

columns in
deleting, Selecting individual columns from one or more tables
selecting individual, Selecting individual columns from one or
more tables



sorting selected, Selecting individual columns from one or more
tables

combining data from tables and, Create a crosstab query
creating Web App, Creating a query
crosstab, creating, Creating a crosstab query with the Query Wizard
Delete

adding filter criteria to, Deleting data in tables with a Delete query
deleting data in tables with, Deleting data in tables with a Delete
query

eliminating duplicate values, Eliminating duplicate values
linking forms to, Linking a form to a query
Make Table, Creating a table by using a Make Table query
presentation of data in, Selecting data using queries
prompting with parameters, Prompting to filter data with parameters
resolving ambiguous outer joins, Resolving ambiguous outer joins
resolving problems with mixed joins, Creating an additional query to
resolve a problem with mixed joins
returning top matched records, Returning the top matched records
saving filter as, Filtering combinations of choices with Advanced
Filter/Sort
summary

creating calculations in, Creating a summary calculation
symbols used in filtering, Add a second set of criteria
tables in

joining multiple, Sort by selected columns
selecting all columns, Selecting all columns from a table
selecting individual columns, Selecting individual columns from
one or more tables

Update
changing data in tables with, Changing data in a table with an
Update query
updating columns based on expressions with, Updating a column
based on an expression

using multiple criteria in filtering, Filtering by single and multiple
combinations of choices

query by form method, Linking a form to a query



query design mode, using build button to enter, Changing the data source for
a form
Query Design option, Creating a table by using a Make Table query
query design tool, selecting all columns from table using, Selecting all
columns from a table
Query menu choice, Creating a query
Query Wizard

creating crosstab queries with, Creating a crosstab query with the Query
Wizard
Find Unmatched Query option in, Joining tables to see unmatched or
missing records

R

Record Number box, Moving between records and using Find And Replace
Record Source field

in Datasheet view, Designing with a Datasheet view
in List Details view, Designing with a List Details view
in summary view, Designing with a summary view

Record Source property, changing to SQL string, Changing the data source
for a form
records

creating summary data for, Creating summary data for records
deleting, Deleting records
editing in Datasheet view, Designing with a Datasheet view
inserting and updating in datasheets, Inserting and updating records
moving between, Moving between records and using Find And Replace
returning top matched, Returning the top matched records
searching, Moving between records and using Find And Replace
storing multiple documents on, Creating bound and unbound object
frames
undoing value using Esc key, Inserting and updating records

rectangle icon, Creating lines and rectangles
rectangles, creating, Creating lines and rectangles
referential integrity, relationships enforcing, Add a relationship
refreshing linked tables, Refreshing linked tables when files are changed



Related Items Control (RELIC), Working with the List view
Relationship diagrams, hiding tables in, Viewing relationships
relationships

about, Viewing relationships
adding, Adding relationships
deleting, Deleting relationships, Deleting records
displaying with subdatasheets, Displaying related information with a
subdatasheet
enforcing referential integrity, Add a relationship
in Web Apps, Modifying a Web App, Importing from an Access desktop
database
joining tables using, Sort by selected columns
using Lookup Wizard for creating, Creating relationships by using the
Lookup Wizard
viewing, Viewing relationships

Relationships diagrams, creating or editing relationships between tables in,
Adding relationships
RELIC (Related Items Control), Working with the List view
Remove layout option, Working with control layouts
removing (see deleting)
renaming, views using settings/actions options, Open, rename, duplicate, or
delete a view
repairing databases, Administrating a database
Report Design Tools tab, Arrange tab from, Alter the size and position of a
control
Report icon, Working with layout view, report view, and Print Preview
Report Properties pane, Link Master Fields in, Creating a parent/child report
report view, Working with layout view, report view, and Print Preview
Report Wizard, Creating a tabular report with multiple tables
reports

about, Preparing data to print using reports
about layout view in, Creating a table in layout view
adding

running sums to, Adding a running sum
sorting and grouping in, Adding sorting and grouping on reports

adding conditional formatting to, Adding conditional formatting



altering presentation of controls on pages, Altering the presentation of
controls on a page
avoiding blank pages in, Avoiding blank pages
changing layout options in, Create a tabular report
changing name of, Create a tabular report
creating multiple table tabular, Creating a tabular report with multiple
tables
creating parent/child reports, Creating a parent/child report
default view of, Altering the presentation of controls on a page
displaying reports in Print Preview, Create a tabular report
handling word wrap in, Using the Can Grow and Can Shrink Properties
layout view in, Working with layout view, report view, and Print
Preview
managing columns and rows in, Using labels and managing columns and
rows
managing page breaks in, Managing data and page breaks
opening, Switch between report view and Print Preview
Print Preview in, Working with layout view, report view, and Print
Preview
report view in, Working with layout view, report view, and Print
Preview
using labels in reports, Using labels and managing columns and rows
vs. forms, Creating a tabular report with multiple tables

ReportView vs. PrintPreview, Preparing data to print using reports
Requery macro command, Link a form to a table or query
ribbon, removing sort using, Sorting datasheet rows
rich text formatting, recording changes to text and, Recording changes to text
and rich text formatting
RIGHT functions, Updating a column based on an expression
Row Height option, Adjusting column/row height and formatting
rows

adding multiple criteria in, Filtering by single and multiple combinations
of choices
adjusting fonts in, Adjust row font
adjusting height of, Adjusting column/row height and formatting
eliminating duplicate, Eliminating duplicate values



formatting in datasheets, Adjust row font
managing in reports, Using labels and managing columns and rows
selecting area of, Select an area of data
sorting datasheet, Sorting datasheet rows

Rows & Columns group, to alter presentation of reports, Working with layout
view, report view, and Print Preview
Run (macro) button, Processing data with action queries
Running Sum property, Adding a running sum
running sums, adding to reports, Adding a running sum
RunSavedImportExport action, Executing a saved import/export
RunSavedImportExport macro command, Disable Trusted Documents

S

Save As Query option, applying to filter, Save a filter as a query
Save button, on action bar, Working with the List view
Save icon, Adding a blank table
Save Import Steps check box, Export data to Excel
Save Selection As New Data Type option, Create a new data part
Save The Value For Later Use option, Create an option group
saved import/export processes, executing, Executing a saved import/export
Saved Imports icon, Working with saved imports and exports
searching, records, Moving between records and using Find And Replace
Select Column icon, Create a multiple items form
Select Layout option, Working with control layouts
select queries vs. action queries, Modifying data using queries
selecting

multiple columns, Altering the presentation by ordering, hiding, and
freezing fields
multiple controls, Designing with a List Details view
tables from navigation pane, Showing the navigation pane
tables from Table Selector, Showing the navigation pane
Team Site, Creating a custom Web App

Selection Type drop-down list, Changing the data source for a form
semicolon (;), separating Input Mask sections, Make a field required and add
an input mask



Set Warnings macro command, Processing data with action queries, Empty
and populate a table of data
SetProperty command, Change other controls
settings/actions

changing options for views, Open, rename, duplicate, or delete a view
modifying Table Selector, Modifying the Table Selector

Settings/Actions charm, Showing the navigation pane
SetValue Macro command, Change other controls
shape fill icon, Creating lines and rectangles
shape outline icon, Creating lines and rectangles
Short Text data type

desktop database, Change field captions and descriptions
desktop database table, Create a blank desktop database
SQL Server, Change the design of a table

Show Grand Total check box, Adding sorting and grouping on reports
Show Subtotal In Group Footer check box, Adding sorting and grouping on
reports
Show Table icon, on Design tab, Sort by selected columns
Show Table popup window, Adding relationships, Selecting all columns from
a table, Sort by selected columns
single record forms (subforms)

adding
fields in Design view, Adding fields to a form in design view
fields in layout view, Adding fields to a form in layout view
to existing form in Design view, Adding a subform to an existing
form

changing Default View property from continuous forms to, Working
with form views
creating parent-child forms with, Creating a parent/child form with the
Form Wizard
creating with Form Wizard, Creating a single record form with the Form
Wizard
dragging into continuous forms, Working with tab controls
dragging onto continuous forms, Adding a subform to an existing form
for presentation of data, Improving presentations with forms
stacked layouts in, Working with control layouts, Adding fields to a



form in layout view
Single Step icon, using with macros, Processing data with action queries
Site Contents menu choice, Finding your site and navigating to the team site
Sizing & Ordering group, Align icon in, Alter the size and position of a
control
Sort & Filter group, text shown beside icons in, Filtering combinations of
choices with Filter By Form
sort option on ribbon, Sorting datasheet rows
Sort option, Advanced Filter/, Filtering combinations of choices with
Advanced Filter/Sort
sorting

datasheet rows, Sorting datasheet rows
order of fields in datasheets, Sorting datasheet rows

split forms, creating, Creating a split form
SQL Server data types, Change the design of a table
SQL Server view vs. Access query, Adding a table template
SQL Server, refreshing linked tables from, Refreshing linked tables when
files are changed
SQL string, changing Record Source property to, Changing the data source
for a form
SQL, viewing to check table name, Create a table by using a Make Table
query
stacked layouts, in single record forms, Working with control layouts,
Adding fields to a form in layout view
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